THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

© 2003-2013 Cisco Systems, Inc. All rights reserved.
CONTENTS

Preface xi
Change History xi
About This Guide xi
Audience xii
Organization of This Guide xii
Related Documents xii
Documentation and Support xii
Field Alerts and Field Notices xii
Documentation Feedback xii
Conventions xiii

CHAPTER 1 Agent Greeting 1
Capabilities 1
Agent Greeting Phone Requirements (for Local Agents Only) 1
Agent Greeting Functional Limitations 2
Whisper Announcement with Agent Greeting 2
Initial Setup 3
Configuration Requirements 3
Agent Greeting Deployment Tasks 4
Configure Media Server for Agent Greeting 4
Media Server Hardware and Network Requirements 5
Prepare a Media Server 5
How Greeting Files Are Recorded and Served 7
Add and Configure Media Servers in CVP 8
Republish .tcl scripts to VXML Gateway 8
Set Cache Size on VXML Gateway 9
Create Voice Prompts for Recording Greetings 9
Peripheral Call Types for Agent Greeting 26
Serviceability 27

CHAPTER 2

Agent Request 29

Agent Request Feature Description 29
Agent Request Prerequisites 30
Agent Request Call Flow 31
Agent Request Scenarios 32

Configure Unified CCE for Agent Request 32

Configuration Manager 32
Configure Network VRU and Network VRU Script 33
Configure the Media Routing PG and PIM 33
Configure Call Type 33
Configure Dialed Number/Script Selector 34
Configure ECC Variables 34

Set up the Media Routing PG and PIM 34

Configure SocialMiner for a Voice Callback Agent Request 35
Configure SocialMiner to Allow MR PG Connections 36
Create Feed 36
Create Campaign 37
Create Notification 37

Create Script for Agent Request 37
Sample Code to Create Customer Callback Request 39
Agent Request Reporting 40

CHAPTER 3

Mobile Agent 43

Capabilities 43
Cisco Unified Mobile Agent description 43
Unified Mobile Agent extends Unified CCE/Unified CCH capabilities 45
Unified Mobile Agent provides agent login flexibility 45
Connection modes 45
Call by Call 46
Nailed connections 47
Connect Tone 47

Agent Greeting and Whisper Announcement 48
Agent Greeting 48
Whisper Announcement 49

Feature requirements 49
  Hardware and software requirements 49
  Phone requirements 49
  Conference requirements 49
  CTI port requirements 50

Supported Unified CCE/Unified CCH features 50
  Fault tolerance support 51

Important considerations 51
  Failover 51
  Performance 52
  Codec 52
  Silent monitoring 53
  Mobile Agent scalability 54
  Unsupported features 54

Unified Mobile Agent call flows 54
  About figures in this section 54
  Inbound call flow 55
  Local consult calls 56
  Remote consult calls 57
  Remote conference calls 58
  Outbound Option call flow 59

Unified Mobile Agent reporting 60

Initial Setup 61
  Summary of Unified Mobile Agent system configuration tasks 61
  Unified CM CTI port configuration and mapping for Unified Mobile Agent 61
    Music on Hold design 62
    Configure Unified CM CTI port Pools for Unified Mobile Agent 63
    Map local and remote CTI ports with Peripheral Gateway user 64
    Create Agent-Targeting Rules for LCP Ports 64
  Maximum Call Duration Timer Configuration 65
    Configure Maximum Call Duration Timer 65
  Agent Desk Setting configuration for Unified Mobile Agent 65
    Configure Agent Desk Settings with Configuration Manager 66
Device configuration for Unified Mobile Agent 67
Cisco CTIOS configuration for Unified Mobile Agent 67
CTIOS installation and Unified Mobile Agent 67
Call delivery mode and agent profiles 68
Prevent Duplicate Logins to the Same AgentID 68
Media Termination Points configuration 68
Configure Media Termination Points in Unified CM 69
Add MTP Resources to Unified CM 69
Configure Media Termination Point Resources in Unified CM 70
Associate Media Resource Group List with Device Pools 71
Quarantine Unified CM Software-Based Resources 71
Insert MTPs 71
Enable Call Progress Tones for Agent-Initiated Calls 72
Verify MTP Resource Utilization 72
Enabled Connect Tone feature 72
Enable Mobile Agent Connect Tone 73
Administration and Usage 73
CTIO Agent Desktop 73
Log in to CTIO Agent Desktop 73
Verify login 75
Enable ringtone 76
Enable Ready State 76
Initiate a Call 77
Transfer a Call 77
Conference a call 77
Cisco Agent Desktop 78
Log in to Cisco Agent Desktop 78
Verify login to Cisco Agent Desktop 80
Enable Ready state 80
Initiate a call 80
Transfer a call 81
Conference a call 81
Cisco Finesse 82
Sign in to Cisco Finesse Agent Desktop 83
Verify sign-in to Cisco Finesse 84
Enable Ready state 84
Make a call 85

CHAPTER 4  Precision Routing  87
  Capabilities  87
    Precision Queues  87
    Skill Groups or Precision Queues?  88
    Attributes  89
    Precision Queue Call Flow Example  89
    Scripts for Precision Queues  90
    Precision Queue Script Node  90
    Queuing Behavior of the Precision Queue Node  91
  Initial setup  91
    Add Attributes  91
    Search for Agents  92
    Assign Attributes to Agents  93
    Add precision queue  93
    Consider If Formula for Precision Queue  97
    Build Precision Queue Steps  98
    Configure a Static Precision Queue  101
    Configure a Dynamic Precision Queue  101

CHAPTER 5  Whisper Announcement  103
  Whisper Announcement Capabilities  103
  Whisper Announcement Functional Limitations  103
  Deployment Tasks  104
    Create Whisper Announcement Audio Files  104
    Deploy Whisper Announcement Audio Files to Media Server  105
      Using a Default Media Server  105
    Configure Whisper Service Dialed Numbers  105
      Configure Dialed Numbers  106
      Change the Whisper Announcement Default Dialed Number  106
    Configure Ringtone Dialed Number  106
      Dialed Number in the Dial-Peer  106
    Add Whisper Announcement to Routing Scripts  107
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify Whisper Announcement Call Variable</td>
<td>107</td>
</tr>
<tr>
<td>Specify Unified CVP Media Server Information</td>
<td>107</td>
</tr>
<tr>
<td>Specify Whisper File Locale and Application Directories</td>
<td>108</td>
</tr>
<tr>
<td>Specify Locale Directory</td>
<td>108</td>
</tr>
<tr>
<td>Specify Application Directory</td>
<td>108</td>
</tr>
<tr>
<td>Variable Length for Media Server Locale and Application Directory Variables</td>
<td>108</td>
</tr>
<tr>
<td>Test Whisper Announcement File Path</td>
<td>109</td>
</tr>
<tr>
<td>Other Script Settings That Are Required for Whisper Announcement</td>
<td>109</td>
</tr>
<tr>
<td>Fail-Safe Timeout for Whisper Announcement in Unified CCE</td>
<td>109</td>
</tr>
<tr>
<td>Whisper Announcement Sample Scripts</td>
<td>110</td>
</tr>
<tr>
<td>WA.ICMS Script</td>
<td>110</td>
</tr>
<tr>
<td>WA_AG.ICMS Script</td>
<td>111</td>
</tr>
<tr>
<td>Import Sample Whisper Announcement Scripts</td>
<td>111</td>
</tr>
</tbody>
</table>
Preface

- Change History, page xi
- About This Guide, page xi
- Audience, page xii
- Organization of This Guide, page xii
- Related Documents, page xii
- Documentation and Support, page xii
- Field Alerts and Field Notices, page xii
- Documentation Feedback, page xii
- Conventions, page xiii

Change History

<table>
<thead>
<tr>
<th>Date</th>
<th>Change</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/12/2013</td>
<td>Initial publication</td>
<td></td>
</tr>
<tr>
<td>1/14/2014</td>
<td>Removed specific phone model references in part of Mobile Agent chapter.</td>
<td>Moving phone compatibility info to Compatibility Matrix for CSCum24671.</td>
</tr>
</tbody>
</table>

About This Guide

The Cisco Unified Contact Center Enterprise Features Guide explains features you can use in conjunction with Cisco Unified Contact Center Enterprise. For each feature, there is a description, procedures for initial setup, and details on the functionality the feature provides.
Audience

This guide is prepared for:

- Contact center administrators who configure and run the contact center, manage agents, and address operational issues.

Organization of This Guide

The features are organized in alphabetical order, from Agent Greeting to Whisper Announcement.

Related Documents

<table>
<thead>
<tr>
<th>Subject</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design considerations and guidelines for deploying a Unified CCE solution, including its various components and subsystems.</td>
<td>Cisco Unified Contact Center Enterprise Design Guide</td>
</tr>
</tbody>
</table>

Documentation and Support


You can also subscribe to the What's New in Cisco Product Documentation RSS feed to deliver updates directly to an RSS reader on your desktop. The RSS feeds are a free service. Cisco currently supports RSS Version 2.0.

Field Alerts and Field Notices

Note that Cisco products may be modified or key processes may be determined important. These are announced through use of the Cisco Field Alert and Cisco Field Notice mechanisms. You can register to receive Field Alerts and Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive announcements by selecting all products of interest.

Log into www.cisco.com; then access the tool at: http://www.cisco.com/cisco/support/notifications.html

Documentation Feedback

To provide comments about this document, send an email message to the following address: contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.
## Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **boldface font** | Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:  
  - Choose **Edit** > **Find**.  
  - Click **Finish**. |
| **italic font** | Italic font is used to indicate the following:  
  - To introduce a new term. Example: A *skill group* is a collection of agents who share similar skills.  
  - For emphasis. Example: *Do not* use the numerical naming convention.  
  - A syntax value that the user must replace. Example: IF *(condition, true-value, false-value)*  
  - A book title. Example: See the *Cisco Unified Contact Center Enterprise Installation and Upgrade Guide*. |
| **window font** | Window font, such as Courier, is used for the following:  
  - Text as it appears in code or that the window displays. Example:  
    `<html><title>Cisco Systems, Inc.</title></html>` |
| `< >`         | Angle brackets are used to indicate the following:  
  - For arguments where the context does not allow italic, such as ASCII output.  
  - A character string that the user enters but that does not appear on the window such as a password. |
Agent Greeting

Capabilities

The Agent Greeting feature lets an agent record a message that plays automatically to callers when they connect to the agent. The greeting message can welcome the caller, identify the agent, and include other useful contextual information. With Agent Greeting, each caller can receive a clear, well-paced, language-appropriate, and enthusiastic introduction. Another benefit is that it saves the agent from having to repeat the same introductory phrase for each call. It also gives the agent a moment to review the desktop software screen pop-ups while the greeting plays.

The process of recording a greeting is much the same as recording a message for voice mail. Depending on how the call center is set up, agents may be able to record different greetings that play for different types of callers (for example, an English greeting for English speakers or an Italian greeting for Italian speakers).

By default, greeting play is enabled when agents log in to their agent desktop. Agents can turn greeting play off and on as necessary.

Agent Greeting Phone Requirements (for Local Agents Only)

Agent Greeting is available to agents and supervisors who use IP Phones with Built-In Bridge (BIB). These agents are typically located within a contact center. Phones used with Agent Greeting must meet these requirements:

- The phones must have the BIB feature.
If you disable BIB, the system attempts to use a conference bridge for agent greeting call flow and raises a warning event.

Note

- The phones must be running firmware version CM 8.5(1) or greater. (In most cases, phone firmware upgrades automatically when you upgrade your Unified Communications Manager installation.)
- See the Cisco Unified Contact Center Enterprise Compatibility Matrix at [http://docwiki.cisco.com/wiki/Compatibility_Matrix_for_Unified_CCE](http://docwiki.cisco.com/wiki/Compatibility_Matrix_for_Unified_CCE) for the list of supported Cisco Unified Call Center phone models.

Agent Greeting Functional Limitations

Agent Greeting is subject to these limitations.

- Agent Greeting does not support outbound calls made by an agent. The announcement plays for inbound calls only.
- Only one Agent Greeting file plays per call.
- Supervisors cannot listen to agent recorded greetings.
- Agent Greetings do not play when the router selects the agent through a label node.
- The default CTI OS Toolkit Agent desktop includes the Agent Greeting buttons. If you do not set up Agent Greeting, the Agent Greeting buttons do not execute any functionality. If you use the default desktop but do not plan to use Agent Greeting, you should remove the buttons.
- Agent Greeting supports Silent Monitoring (CTI OS and Unified CM-based) with this exception: For Unified-CM based Silent Monitoring, supervisors cannot hear the greetings themselves. If a supervisor clicks the Silent Monitor button in their CTI OS desktop while a greeting is playing, a message displays stating that a greeting is playing and to try again shortly.

Whisper Announcement with Agent Greeting

You can use Agent Greeting with the Whisper Announcement feature. Here are some things to consider when using them together:

- On the call, the Whisper Announcement always plays first.
- To shorten your call-handling time, use shorter Whisper Announcements and Agent Greetings than you might if you were using either feature by itself. A long Whisper Announcement followed by a long Agent Greeting equals a long wait before an agent actively handles a call.
- If you use a Whisper Announcement, your agents probably handle different types of calls: for example, “English-Gold Member-Activate Card,” “English-Gold Member-Report Lost Card,” “English-Platinum Member-Account Inquiry.” Therefore, you may want to ensure that greetings your agents record are generic enough to cover the range of call types.
Initial Setup

This section is intended for system administrators responsible for installing and configuring Unified CCE. It describes the one-time tasks required to set up Agent Greeting.

Configuration Requirements

The following configuration components must be in place to deploy Agent Greeting.

<table>
<thead>
<tr>
<th>Where</th>
<th>What</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified Communications Manager</td>
<td>For phones that use Agent Greeting, you must set the Built-in-Bridge option to On or Default (if the value of Default is On). To verify, in Unified CM Administration, select Device &gt; Phone &gt; Built in Bridge.</td>
</tr>
</tbody>
</table>
| Unified CCE | Agent Greeting is supported with Type 10 Network VRUs only. (Type 10 is required to allow CVP to control the call). If your current Unified CCE deployment is not configured for a Type 10 VRU, you must modify it accordingly. Agent Greeting requires at minimum three expanded call variables.  
  - user.microapp.ToExtVXML: This is used twice in an Agent Greeting record script: the first time is to queue the Unified CVP RecordAgentGreeting application; the second time is to tell the recording application where to save greeting files. Configure it as an array with size 3. Use the Unified CCE Administration tool to ensure this variable includes these settings: Maximum Length - 100 and Enabled.  
  - user.microapp.app_media_lib: This is required in Agent Greeting record and play scripts to specify the dedicated directory on the media server where your greeting audio files are stored. Maximum Length - 100 and Enabled.  
  - user.microapp.input_type: This is required in Agent Greeting record scripts to limit the allowable input type to DTMF. Maximum Length - 100 and Enabled.  
  No other expanded call variables are needed if you serve your files from the Unified CVP default media server, and your files are in the media server default locale directory ("<web_server_root>en-us\app"). However, if you store your files in a location other than these defaults, you must use one or more of the expanded call variables in the next row in your scripts. |
| Unified CCE (optional variables, used to override defaults) | To make these variables available to your script authors, confirm that they are defined in the Unified CCE Administration tool. For instructions about defining ECC variables for CVP, see the Cisco Unified Customer Voice Portal Configuration and Administration Guide at http://www.cisco.com/en/US/products/sw/custcsw/ps1006/tsd_products_support_series_home.html.  
  - user.microapp.media_server: Use to identify the Unified CVP media server if it is other than the default.  
  - user.microapp.locale: Use to specify the name of the locale directory on the media server if it is other than the default ("en-us").  
  - user.microapp.UseVXMLParms: Required in your record script if you include the user.microapp.media_server variable. It tells the external VXML recording script to use the name/value pair of the application that you pass in the user.microapp.ToExtVXML variable. |
Agent Greeting Deployment Tasks

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Ensure your system meets the baseline requirements for software, hardware, and configuration described in the System Requirements and Limitations section.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure one or more servers to act as media servers. Configuration requirements include IIS and FTP.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In CVP, add media servers, configure FTP connection information, and deploy the media servers.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure a Unified CVP media server, if you have not already done so. See <strong>Configure Media Server for Agent Greeting</strong>, on page 4.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In Unified CVP, republish the VXML Gateway.tcl scripts with updated Agent Greeting support. See <strong>Republish .tcl scripts to VXML Gateway</strong>, on page 8 for Agent Greeting support.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Set the cache size on the VXML Gateway. See <strong>Set Cache Size on VXML Gateway</strong>, on page 9.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Record the voice prompts to play to agents when they record a greeting and to deploy the audio files to your media server, see <strong>Create Voice Prompts for Recording Greetings</strong>, on page 9.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Configure Call Types, on page 10 to record and play agent greetings.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Configure Dialed Numbers, on page 10 to record and play agent greetings.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Schedule the Script, on page 11</td>
</tr>
<tr>
<td>Step 11</td>
<td>Define Network VRU Scripts for Agent Greeting, on page 11.</td>
</tr>
</tbody>
</table>
| Step 12 | In Script Editor:  
  - To use the installed scripts to record and play agent greetings, see **Import example Agent Greeting scripts**, on page 13.  
  - To create your own scripts, see **Agent Greeting Scripts**, on page 17. |
| Step 13 | Modify the Unified CCE call routing scripts to use **Play Agent Greeting script**, on page 15. |

**Configure Media Server for Agent Greeting**

Agent Greeting uses the Unified CVP media server. If you previously configured and deployed one or more Unified CVP media servers for other features, you do not have to configure any additional servers for Agent Greeting. You can optionally add additional media servers.

Agent Greeting uses the Unified CVP media server to store and serve the following types of files:
• Prompt files, prepared by Administrators. These files supply the prompts that agents hear when they record their greetings. The Administrator must manually add the prompt files to all of the media servers that their Agent Greeting scripts will query to retrieve those files.

• Greeting files, recorded by agents. These files are the actual greetings that play to callers. They are recorded by individual agents. The system handles the storage of these files as follows:
  ◦ A greeting file is named using the convention AgentGreetingType_agentID. For more about AgentGreetingType, see Specify AgentGreetingType Call Variable, on page 15.
  ◦ When a greeting is first recorded, it is stored temporarily on the Unified CVP Call Server, where an agent can listen to it prior to confirming its use.
  ◦ When the agent confirms the greeting, the file is transferred, using FTP, to all media servers that are deployed and are configured with FTP enabled. Make sure an FTP server is installed and configured for the correct version of IIS on the media server. For instructions consult the Microsoft corporation (http://microsoft.com).
  ◦ To satisfy a request for the greeting to play to a caller, the greeting file is copied from the media server to the VXML Gateway, where it is cached. The cached copy is used to satisfy subsequent requests for the greeting. Content expires in the cache based on the cache timeout period defined on the media server.

The routing scripts look for the prompt and greeting files either on the configured default Unified CVP media server or on a specific server identified in the script. Some typical scripting scenarios for retrieving files for Agent Greeting include:

• All files are retrieved from the default server.
• All files are retrieved from the default server if available; otherwise, a redundant server is queried.
• For security, the prompt files are retrieved from one server and the greetings files are retrieved from a different server.
• For load balancing, the greetings files are dispersed among several servers and retrieved based on tests in the script.

Media Server Hardware and Network Requirements

1 Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.

2 See the Unified CVP Hardware and System Software Functional Specification for information about Media Server hardware requirements and co-resident software compatibilities.

Prepare a Media Server

1 Ensure that IIS is properly configured and running on the server. It must be listening on port 80.

2 Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.

3 Perform the following steps:
   a On the taskbar, click Start, point to Administrative Tools, and then click Server Manager.
   b In the Server Manager hierarchy pane, expand Roles, and then click Web Server (IIS).
c In the Web Server (IIS) pane, scroll to the Role Services section, and then click Add Role Services.
d On the Select Role Services page of the Add Role Services wizard, expand FTP Server.
e Select FTP Service.

**Note** To support ASP.NET membership or IIS Manager authentication for the FTP service, you need to select FTP Extensibility.

f Click Next.
g On the Confirm Installation Selections page, click Install.
h On the Results page, click Close.
i In the sites section, click Add FTP Site. Provide a site name and path to the same location as the http directory c:\inetpub\wwwroot.
j Select your desired binding method, specify to start automatically, select No SSL and click Next.
k On the Authentication and Authorization section select the type of authentication required. If using basic, note the name and password of the account.
l Select the authorization; for anonymous select Anonymous users.
m Set the read and write permissions.

**Note** Make note of your FTP connection information -- connection type, user name, password, and port number.

4 Make sure that the FTP and the IIS share the same root directory, because the recording application writes the file to the media server directory structure, and the greeting playback call uses IIS to fetch the file. The \en-us\app directory should be under the same root directory for FTP and IIS.

5 Create a dedicated directory on the server to store your greeting files. This lets you specify a lower cache timeout of 5 minutes for your agent greeting files that does not affect other more static files you may be serving from other directories. By default, the Record Greeting application posts the .wav file to the \en-us\app directory under your web/ftp root directory. You may create a dedicated directory such as \ag_gr under the \en-us\app directory, and then indicate this in the Unified CCE script that invokes the recording application. Use the array for the ECC variable call.user.microapp.ToExtVXML to send the ftpPath parameter to the recording application. Make sure the ECC variable length is long enough, or it may get truncated and fail.

6 In IIS Manager, set the cache expiration for the dedicated directory to a value that allows re-recorded greetings to replace their predecessor in a reasonable amount of time, while minimizing requests for data to the media server from the VXML Gateway. The ideal value varies depending on the number of agents you support and how often they re-record their greetings. Two minutes may be a reasonable starting point.

7 Also find the site you are using, go to the agent greeting folder you created (ag_gr), and then select HTTP Response Headers.

8 Select Add, then Set Common Headers.

9 Select Expire Web Content and set your desired value.
After specifying the cache timeout, it is a good idea to clear the cache on the VXML Gateway. This ensures the gateway requests the latest files from the media server. You need only clear the gateway cache once. Open a command prompt on the CVP VXML Gateway, log into IOS, and enter the following commands:

```
my_server# conf t
my_server(config)# clear http client cache
my_server(config)# exit
my_server(config)# wr
```

The HTTP client response timeout setting on the gateway must be greater than the time it takes to complete the largest anticipated FTP file transfer. If an FTP file transfer takes longer than the configured duration in seconds for HTTP client response timeout, the FTP transfer completes correctly, but the call drops as soon as the configured timeout duration is met. To change the HTTP client response timeout setting, open a command prompt on the CVP VXML Gateway, log into IOS, and enter the following commands:

```
my_server# conf t
my_server(config)# http client response timeout <new value in seconds>
my_server(config)# exit
my_server(config)# wr
```

By default, the HTTP client response timeout value for CVP is 30 seconds.

---

**How Greeting Files Are Recorded and Served**

Following is an illustration of how Greeting files are recorded and served, followed by a step by step description.
1. An agent initiates a greeting recording session and records a greeting.
2. The VXML Gateway passes the recorded (but unsaved) greeting file to the VXML Server.
3. The agent asks to listen to the greeting before saving it. The file is played from the VXML Server.
4. The agent saves the greeting. The file is named (based on the agent Login Name + AgentGreetingType) and stored on the media server.
5. Requests for the greeting file come in through the VXML Gateway. The VXML Gateway examines its web server cache for the file. If the file is present and not expired, the cached version is served. If the file is not present, or if its timestamp exceeds the cache expiration, the file is retrieved from the media server and cached again.

Add and Configure Media Servers in CVP

You can add one or more servers to CVP to act as media servers. If you add multiple media servers, note the following:

- CVP automatically propagates files that are added to one media server out to all media servers in the list that have FTP enabled. To enable FTP on a media server, use the following procedure.
- You can designate one media server as the default. If a default media server is defined, requests for files are automatically sent to that server without your having to specify that server in your routing scripts.

2. At the CVP Operations Console, select Device Management > Media Server.
3. Add a server to the list of CVP media servers.
4. Select FTP Enabled.
5. Configure the credentials and port settings that will permit CVP to write files to the server using FTP.
6. Optionally, you can designate one of your media servers as the Default Media Server.
7. Click the Deploy button to deploy the list of media servers to your CVP Call Servers.
   Note: If you deploy the list of media servers and then designate a default, you must redeploy the list.

Republish .tcl scripts to VXML Gateway

The .tcl script files that ship with Unified CVP Release 9.0(1) include updates to support Agent Greeting. You must republish these updated files to your VXML Gateway.

Republishing scripts to the VXML Gateways is a standard task in CVP upgrades. If you did not upgrade CVP and republish the scripts, you must republish the scripts before you can use Agent Greeting.
Procedure

**Step 1**  In the Unified CVP Management Console, select **Bulk Administration > File Transfer > Scripts and Media**.

**Step 2**  Set Device to Gateway.

**Step 3**  Select the gateways you want to update. Typically you would select all of them unless you have a specific reason not to.

**Step 4**  Select **Default Gateway Files**.

**Step 5**  Click **Transfer**.

---

**Set Cache Size on VXML Gateway**

To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum allowed. The maximum size is 100 megabytes; the default is 15 kilobytes. Failure to set the VXML Gateway cache to its maximum can result in slowed performance to increased traffic to the media server.

Use the following Cisco IOS commands on the VXML Gateway to reset the cache size:

```plaintext
conf t
http client cache memory pool 100000
exit
wr
```


---

**Create Voice Prompts for Recording Greetings**

You must create audio files for each of the voice prompts that agents hear as they record a greeting. The number of prompts you require can vary, but a typical set can consist of:

- A welcome followed by a prompt to select which greeting to work with (this assumes you support multiple greetings per agent)
- A prompt to select whether they want to hear the current version, record a new one, or return to the main menu
- A prompt to play if a selected greeting is not found.

To create voice prompts for recording greetings:

**Procedure**

**Step 1**  Create the files using the recording tool of your choice. When you record your files:

- The media files must be in .wav format. Your .wav files must match Unified CVP encoding and format requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).
- Test your audio files. Ensure that they are not clipped and that they are consistent in volume and tone.
Step 2 After recording, deploy the files to your Unified CVP media server. The default deployment location is to the `<web_server_root>\en-us\app` directory.

Step 3 Note the names of the files and the location where you deployed them on the media server. Your script authors need this information for the Agent Greeting scripts.

**Built-In Recording Prompts**

The Unified CVP Get Speech micro-application used to record Agent Greetings includes the following built-in prompts:

- A prompt that agents can use to play back what they recorded
- A prompt to save the greeting, record it again, or return to the main menu
- A prompt that confirms the save, with an option to hang up or return to the main menu


**Example Record Greeting Prompts**

Unified CCE includes three example record greeting audio prompts. These are installed on each ICM server at `<icm_root>\wav`. These example files are referenced in the example recording script that are included with ICM. If you plan to deploy the example script, copy the audio prompts to the `<web_server_root>en-us\app` directory on your media server.

**Configure Call Types**

To record and play agent greetings, create the following call types.

**Procedure**

Step 1 In Unified CCE Administration, select Manage > Call Type.

Step 2 Create a call type to record agent greetings and use the name RecordAgentGreeting.

Step 3 Create a call type to record agent greetings and use the name PlayAgentGreeting.

**Configure Dialed Numbers**

To record and play agent greetings, create the following dialed numbers.
Procedure

Step 1  In Unified CCE Administration, select Manage > Dialed Number.
Step 2  Create a dialed number to record agent greetings and use the name RecordAgentGreeting. The name must match exactly and is case-sensitive.
Step 3  Create a dialed number to record agent greetings and use the name PlayAgentGreeting. The name must match exactly and is case-sensitive.
Step 4  Complete the following for each dialed number:
   a)  For routing type, use Internal Voice.
   b)  Leave domain as is. The domain defaults to a set value and you cannot change it.
   c)  To associate each number to its call type (and to a script that will execute), select the call type that matches the purpose of each dialed number.

Schedule the Script

Procedure

Step 1  Select Script > Call Type Manager.
Step 2  From the Call Type Manager screen, select the Schedule tab.
Step 3  From the Call type drop-down list, select the call type to associate with the script; for example, PlayAgentGreeting.
Step 4  Click Add and select the script you want from the Scripts box.
Step 5  Click OK twice to exit.

Define Network VRU Scripts for Agent Greeting

For Agent Greeting record and play scripts to interact with Unified CVP, Network VRU scripts are required. The number of VRU scripts that you require and how you configure them depends on how you choose to script Agent Greeting.

To create these scripts, use the Network VRU Script List Tool found in Configuration Manager

The following table lists an example set of Agent Greeting Network VRU scripts based on the example Agent Greeting scripts that are included with the software.

Note  If you require the following example VRU scripts, you must manually create them.

- The Network VRU must be a Type10
- The default timeout 180 is acceptable
Leave Overridable unchecked

Table 1: Agent Greeting Network VRU Scripts

<table>
<thead>
<tr>
<th>Name / VRU Script Name</th>
<th>Configuration Parameter</th>
<th>Interruptible (Y/N)</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>AgentGreeting</td>
<td>null</td>
<td>N</td>
<td>Causes a saved greeting audio file to play. The -a parameter automatically generates the file name by concatenating the agent's Login Name with the AgentGreetingType variable value set in your routing scripts that target an agent.</td>
</tr>
<tr>
<td>GreetingMenu_1_to_9</td>
<td>1-9</td>
<td>Y</td>
<td>During a recording session, play an audio file that presents a voice menu prompting the agent to press the number corresponding to the greeting he or she wants to record. The 1-9 configuration parameter defines the range of allowable keys. So this value also determines the number of concurrent greetings agents can have. The A parameter specifies that the file is in the (default) Application directory on the Unified CVP VXML Server.</td>
</tr>
<tr>
<td>GreetingSubMenu</td>
<td>1-3</td>
<td>Y</td>
<td>During a recording session, play an audio file that prompts the agent to press 1 to listen to a greeting, 2 to record, or 3 to go to the main menu.</td>
</tr>
<tr>
<td>Greeting_Not_Found</td>
<td>Y</td>
<td>Y</td>
<td>During a recording session, if an agent tries to play back a greeting that does not exist, play the no_greeting_recorded audio file. The Y configuration parameter in this instance allows barge-in (digit entry to interrupt media playback).</td>
</tr>
<tr>
<td>T10_GS_AUDIUM</td>
<td>,,,,,,,,,,Y</td>
<td>Y</td>
<td>This starts the external VXML application that records the greeting. The VRU script name must be specified exactly as shown and is case-sensitive. The Y parameter in the eleventh position of the Configuration Parameter is required. It allows the script to pass FTP connection information to the VXML server. The VXML server then uses this information to make an FTP connection to the media server when saving greeting files.</td>
</tr>
</tbody>
</table>

Note: For descriptions of VRU Script Name parameters and detailed instructions on creating Network VRU scripts for CVP micro-applications, see the Configuration and Administration Guide for Cisco Unified Customer Voice Portal.
Import example Agent Greeting scripts

To view or use the example Agent Greeting scripts, you must first import them into Script Editor. To import the scripts:

Procedure

**Step 1** Launch Script Editor.
**Step 2** Select **File > Import Script** and select a script to import.

The scripts are located in the *icm\bin* directory on the data server (DS) node.

**Note** When you import the example scripts, Script Editor maps objects that are referenced in the scripts. Some of the objects, such as the external Network VRU scripts, skill groups, route to skill group, or precision queue, do not map successfully. You must create these manually or change these references to point to existing scripts, skill groups, and precision queues in your system.

What to Do Next

In addition to importing the scripts, you may need to modify the following items. For more information, see **Agent Greeting Scripts**, on page 17.

- If you do not use a default media server, you must modify the media server specification.
- If you do not use the default values for application and locale ([en-us/app](#)), you must modify the path name of greeting files.
- Using the Unified CCE Administration tool, enable all expanded call variables referenced by the following sample scripts.

Agent Greeting Example Routing Scripts

The example routing script files in the *icm\bin* directory include:

- **AG.ICMS**—This script sets up an Agent Greeting by setting the greeting type to be used on the call and then queueing the call to a skill group or precision queue. Once an agent is selected from the skill group or precision queue and the call routed to the agent, the PAG.ICMS script is invoked. It requires that you define an AgentGreeting VRU script (described in Define Network VRU Scripts for Agent Greeting, on page 11) and a skill group.

- **PAG.ICMS**—This script causes an Agent Greeting to play. It is invoked by the PlayAgentGreeting dialed number that you configured earlier in the configuration process. This number must be associated with a call type that then executes the script. It requires that you define an AgentGreeting VRU script, described in Define Network VRU Scripts for Agent Greeting, on page 11.

- **RECORD_AG.ICMS**—This script lets agents record a greeting. It is called from the agent desktop when an agent clicks the Record Agent Greeting button. It prompts the agent to select which greeting to play or record. This script is invoked by the RecordAgentGreeting dialed number that you configured earlier in this configuration process. It requires that you define all five VRU scripts described in Define Network VRU Scripts for Agent Greeting, on page 11.
• **WA_AG.ICMS**—This script plays a Whisper Announcement and an Agent Greeting together on the same call flow. It requires that you define an AgentGreeting VRU script (described in Define Network VRU Scripts for Agent Greeting, on page 11) and a skill group.

### Note

The PAG.ICMS and RECORD_AG.ICMS example scripts assume that a default media server is configured in Unified CVP, and the greeting files are stored in a dedicated directory named ag_gr directory. The WA_AG.ICMS script does not include a dedicated directory.

### Note

For greeting, the initial script sets up the call between caller and agent, and a different script plays the greeting to the agent after the caller is connected. If the initial Unified CCE script overrides the default media server with a SET node, the call context of expanded call variables is preserved on the greeting playback call as well, and the Default Media Server may be overridden. In this case, modify the greeting playback script to use a SET node with the correct media server.

---

### Test Agent Greeting File Path

When an agent records a greeting, the greeting file is saved with a system-generated name as follows:

- The file name starts with the value of the Call.AgentGreetingType variable associated with the choice the agent made when recording the greeting. For example, if the agent selected the first option, and the Agent Greeting record script sets the first option to "1," then the greeting file name is appended with _1. As another example, if descriptive strings were implemented, and the first option is associated with the string "French," then the greeting file name starts with French_.
- The agent's id number is appended to the starting string. For agent 10201 would have greeting files named 10201_1 or 10201_French.

The greeting file is saved in a directory whose path is determined by the following variables in the Agent Greeting record script:

- A specific media server, or the default media server. (The file is later pushed to all FTP-enabled media servers.)
- A specific application directory, or the default application directory.
- A specific locale directory, or the default locale directory.

To test the path you defined to the greeting file in your script variables, plug the complete URL into a browser. The .wav file should play. For example:

- If your script uses a default media server whose IP is 192.1.1.28 + the default locale + an application directory named greet + agent123_im1.wav, then the generated URL should be http://192.1.1.28/en-us/app/greet/agent123_1.wav. Entering this URL into a browser should cause this agent's greeting to play.
- If your script includes: http://my_server.my_domain.com + the default locale + an application directory app/greet + agent123_1.wav, then the path should be http://my_server.my_domain.com/en-us/app/greet/agent123_1.wav.
Modify the Unified CCE call routing scripts to use Play Agent Greeting script

For an Agent Greeting play script to run, you must add an AgentGreetingType Set Variable node to your existing Unified CCE call routing scripts: This variable's value is used to select the audio file to play for the greeting. Set the variable before the script node that queues the call to an agent (that is, the Queue [to Skill Group or Precision Queue], Queue Agent, Route Select, or Select node). For more information, see Agent Greeting Example Routing Scripts, on page 13.

Specify AgentGreetingType Call Variable

To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType call variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it should use. The variable value corresponds to the name of the greeting type for the skill group or Precision Queue. For example, if there is a skill group or Precision Queue for Sales agents and if the greeting type for Sales is '5', then the variable value should be 5.

You can use a single greeting prompt throughout a single call type. As a result, use one AgentGreetingType set node per script. However, as needed, you can set the variable at multiple places in your scripts to allow different greetings to play for different endpoints. For example, if you do skills-based routing, you can specify the variable at each decision point used to select a particular skill group or Precision Queue.

Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more than once in any single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Agent Greeting:

- Object Type: Call.
- Variable: Must use the AgentGreetingType variable.
- Value: Specify the value that corresponds to the greeting type you want to play. For example: “2” or “French”
  - You must enclose the value in quotes.
  - The value is not case-sensitive.
  - The value cannot include spaces or characters that require URL encoding.
The following script example illustrates how to include Agent Greeting in a script using the Set Variable node:

**Figure 1: Modified Call Routing Script to Enable Greeting Play**

---

### Scripting Agent Greeting for Multiple Customers

In the out-of-box method for deploying Agent Greeting, Unified CCE uses the customer information from the built-in “PlayAgentGreeting” dialed number to choose the correct network VRU to play the greeting. If your deployment has multiple customers configured within your Unified CCE instance and you want to use Agent Greeting with all of them, you must configure things differently to work around customer associations.

**Configure Custom Dialed Number for Agent Greeting Play**

To play Agent Greetings for multiple customer instances, configure the built-in PlayAgentGreeting dialed number for each Unified CM routing client, but do not associate it with a specific customer. The Unified CM peripheral uses this number to initiate Agent Greeting play. If you want your greetings to be played from a different network VRU, use the TranslationRouteToVRU node in your routing scripts to explicitly choose the network VRU.

**Configure Custom Dialed Number for Agent Greeting Record**

To record Agent Greetings when you have multiple customers, you must create your own custom dialed number for recording. You may want to create different dialed numbers for different customers. As with Agent Greeting play, if you want to use different network VRUs to record Agent Greetings for different customers, use the TranslationRouteToVRU node in your routing script to explicitly select the network VRU.

When you create your own dialed number to record greetings, you cannot use the default Record Greeting button that ships with CTI OS (as it is associated with the hard-coded “RecordAgentGreeting” DN). Create your own custom button or have your agents enter the record dialed number using the dial pad on their desktops.
Include Agent Greeting Controls in Agent Desktops

CTIOS includes ActiveX objects that let you include Agent Greeting controls in your COM and C++ sourced agent desktops. Available controls include Enable Greeting, Disable Greeting, and Record Greeting. For more information, see the CTIOS Developer Guide at http://www.cisco.com/en/US/products/sw/custcosw/ps14/tsd_products_support_series_home.html for more information. Agent Greeting controls are not supported with Java or .NET based CTIOS desktops, or with non-CTIOS desktops such as CAD.

Agent Greeting Scripts

Agent Greeting requires two call routing scripts: one that agents can use to record greetings and one to play a greeting to callers. Examples of these scripts are included in your installation. This section describes the elements in the installed example scripts, including optional features and other modifications that you can make. To create scripts from scratch, use this section to understand the required elements in Agent Greeting scripts.

Note

If you plan to use the installed example scripts out of the box, you can ignore this section.

Agent Greeting Recording Script

The Agent Greeting recording script is a dedicated routing script that allows agents to record greetings. You can use the installed example scripts or create your own.

The script should be called from the agent desktop when an agent clicks the Record Greeting button. If you support multiple greetings per agent, it should include prompts to select which greeting to play or record. The dialed number RecordAgentGreeting must be created for the specific routing client and associated with a call type which then executes this script.

In the example script shown here, the agent is first prompted to select one of nine possible greeting types. After selecting a greeting type, the agent chooses whether to 1) listen to the existing greeting for that type; 2) record a new greeting for that type, or 3) return to the main menu. If the agent selects the option to listen, the name of the application directory on the media server is set and the external VRU script that plays the greeting is triggered. Then the agent is returned to the main menu. If the agent selects the option to record, the Unified CVP recording application is called. The recording application contains its own built-in audio prompts that step the agent through the process of recording and saving a greeting. At the end, the agent is returned to the main menu.

There are several other behaviors in the script to note. An agent may select to listen to a greeting type for which no greeting exists. In that event, a VRU script that plays an error message is called. Also, in two places in the script, the path to the application directory is reset to the default. This is because (in this example) that
is where the files for the audio files reside. The only files that reside outside of the default directory are the greetings themselves.

Figure 2: Agent Greeting Record Script

RecordAgentGreeting Micro-application

Unified CVP includes a dedicated micro-application -- RecordAgentGreeting -- for recording agent greetings. The application lets agents record, review, re-record, and confirm the save of a greeting. It includes audio files to support each of these functions. If an agent is not satisfied with a greeting, it can be re-recorded up to three times. Upon confirmation of a save, the application FTPs the saved file to the media server. Built-in error checking includes checks for the data required to name the file (agent Login Name + AgentGreetingType variable value), media server specification, valid menu selections made by the agent, and successful FTP of the greeting file.

Agent Greeting Record Script Nodes

Using the example script as a reference, here are descriptions of the functions its nodes perform.

Table 2: Script Node Functions for Agent Greeting

<table>
<thead>
<tr>
<th>Node</th>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable:Call:user. microapp.input_type</td>
<td>D</td>
<td>Sets the allowable input type to DTMF (touch tone).</td>
</tr>
</tbody>
</table>
### Agent Greeting Scripts

<table>
<thead>
<tr>
<th>Node</th>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>RunExtScript: Press 1-9 to Select Greeting X</td>
<td>M, press_1_thru_9_greeting,A</td>
<td>Runs the VRU script that defines which digits are valid to select an AgentGreetingType and plays a voice prompt describing the options.</td>
</tr>
<tr>
<td>Variable: Call: AgentGreetingType</td>
<td>Call.CallerEnteredDigits</td>
<td>Sets the AgentGreetingType to the digit the agent pressed. This text is used in the greeting wave file. It can be a simple numbering system or more descriptive titles such as &quot;English.&quot;</td>
</tr>
<tr>
<td>RunExtScript: 1 - hear greeting X, 2 - record greeting X, 3 - return to menu</td>
<td>M, press1-press2-press3,A</td>
<td>Runs the VRU script that defines which digits are valid to select a desired action and plays a voice prompt describing the options.</td>
</tr>
<tr>
<td>CED</td>
<td>1,2,3</td>
<td>Tells the script how to handle the caller entered digits in response to the 1,2,3 external script.</td>
</tr>
</tbody>
</table>
| Variable: Call: user.microapp.app_media_lib | Set three times:  
\* Once to "app/ag_gr"  
\* Twice to "" (an empty string; that is, the default) | Defines the path to the application directory on the Unified CVP media server. Prior to playing the greeting file, it is set to the dedicated greeting file directory (in this example, app/ag_gr). After the greeting file plays, it is reset to the default application directory where (in this example) the files for voice prompts are stored. If the voice prompts were stored in the same directory as the greeting files, there would be no need to reset the path. |
<p>| RunExtScript: Play Recording | PM,-a,A | Runs the VRU script that plays the selected Agent Greeting. |
| RunExtScript: Greeting Not Found | PM, no_greeting_recorded,A | Runs the VRU script that plays an error message if the Agent Greeting selected to play does not exist. |</p>
<table>
<thead>
<tr>
<th>Node</th>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
</table>
| Variable: Call: user.microapp. ToExtVXML[] | Array Index: 2 Value: "ftpPath=<path_to_dedicated/directory>" For example: "ftpPath=en-us/app/ag_gr" | Specifies the FTP information that the VXML server uses to write greeting files to the media server. The information must match the FTP information configured for the media server in the Unified CVP Operations Console. The value for array index must be 2. The value consists of:  
  - ftpPath= to set the path to the dedicated directory for agent greeting files.  
  - The path must begin with the locale directory.  
To view additional setting options, see CVP documentation. |
| Variable: Call: user.microapp. ToExtVXML[] | Array Index: 0 Value: "application=RecordAgentGreeting" | Identifies the external Unified CVP micro-application (RecordAgentGreeting) that is used to record the greeting. The value for array index must be 0. |
| RunExtScript: Run Default Recording Application | GS, Server, V | Runs the VRU script that launches the Get Speech micro-application on the VXML server. |

**Specify Media Server in Routing Scripts**

When you configure media servers in CVP, you can specify a default media server. The benefit to specifying a default media server is that your scripts do not need a Set Variable node to access the default media server. For this to work, you must make sure that the files a script requests are stored on the default server.

If you do not define a default media server, or if you define a default but the files that your script requires are not stored on the default, then the script must include a Set Variable node to identify a media server.

To specify a media server that stores the files required by your script, use the following settings in the Set Variable node:

- Object Type: Call.
- Variable: Must use the user.microapp.media_server expanded call variable.
- Value: Specify the HTTP path to the server. For example: "http://myserver.mydomain.net." You must enclose the path in quotes.
- Alternately you can specify an IP address in place of a hostname.
In scripts that invoke an external VXML application (as the Agent Greeting record script does), if you explicitly set a variable for the media server (user.microapp.media_server), then you must also set the following variables:

- The path to the media server application directory (user.microapp.app_media_lib)
- The CVP UseVXMLParams value to N.(user.microapp.UseVXMLParams)

See the following example.

**Figure 3: Additional Required Variables When Specifying a Media Server**

**Specify Greeting File Locale and Application Directories in Routing Scripts**

CVP uses a default storage directory for media files: `<web_server_root>/en-us/app`. To take advantage of this, Unified CCE call routing scripts automatically add `en-us/app` to the server name when constructing HTTP requests for media files. For example:

- If the script node that defines the media server has a value of "http://myserver.mydomain.com," and
- The script node that defines which audio file to play has a value of "agent123_1.wav", then
- The HTTP request for the file is automatically constructed as
  
  http://myserver.mydomain.com/en-us/app/agent123_1.wav

If your greeting audio files are stored in a different locale directory, you must add a Set Variable node to your script that identifies the locale directory. As you must store your greeting files in a dedicated subdirectory under the locale, you must always add a Set Variable node that identifies that directory.

Use these settings in the Set Variable node to specify your locale directory:

- Object Type: Call.
- Variable: Must use the user.microapp.locale expanded call variable.
- Value: Specify the directory name. For example: "pt-br" (Portuguese-Brazil). You must enclose the path in quotes.

Use these settings in the Set Variable node to specify your application directory:

- Object Type: Call.
- Variable: Must use the user.microapp.app_media_lib expanded call variable.
- Value: Specify the directory name. For example: to use a directory "greet" in place of the default directory "app", enter "greet". To use a sub-directory "greet" under "app" enter "app/greet". You must enclose the path in quotes.
Verify Length for Media Server Locale and Application Directory Variables

If you include Set Variable nodes for the media server, locale, and/or application directories, make sure that the values you set for them do not exceed the Maximum Length settings for their corresponding expanded call variables.

For example, if you include a Set Variable node for the media server with a value of “http://mysubdomain.mydomain.co.uk”, the string is 33 characters long. Therefore, the Maximum Length setting for the user.microapp.media_server expanded call variable must be 33 or greater. Otherwise, the server name is truncated in the HTTP request for the file and the file is not found.

To configure expanded call variables, use the Unified CCE Configuration Manager. Select List Tools > Expanded Call Variables List.

To configure ECC variables, use Unified CCE Administration. Select Manage > Expanded Call Variables.

Descriptive Agent Greeting Type Strings

The previous Agent Greeting record script example stores Agent Greeting Type values as numbers (although in string format). But suppose you prefer more descriptive string names. For example, “English,” “French,” and “Spanish.” Or “Sales,” “Billing,” and “Tech Support.” Descriptive names can make it easier to understand at a glance what different numeric key selections in your scripts correspond to. Note that they also affect how greeting files are named (for example agent123_English.wav as opposed to agent123_1.wav).

The following script example is almost identical to the previous record script, except that it includes four additional nodes (highlighted in green). They consist of an additional CED node that maps the keys 1, 2, and 3 to language names. The Run Ext Script node (in gray) was modified for the new options. The rest of the
script is the same with no other changes required. Note that your routing scripts require a corresponding mapping of numeric keys to language names.

Figure 4: Script with Descriptive Greeting Type Strings

Agent Greeting Play Script

The Agent Greeting feature requires a dedicated routing script that causes the agent greeting to play. This script is invoked by the PlayAgentGreeting dialed number.

The Play script must contain at least two and possibly four specific nodes, depending on other factors. You always need the following nodes:

- A Run External Script node that calls the VRU script that plays the greeting.
- A Set Variable node that sets the directory path to your greeting files.

You may also need to include in your scripts Set Variable nodes that:

- Specify the Media Server: Unified CVP lets you specify a default media server. If you are not serving your audio files from the default media server, your scripts must include a variable that identifies the server where your audio files are stored.
- Specify the Locale Directory: Additionally, if you are not storing your files in the default locale directory `shoulden-us` on the media server, you must include a variable that specifies the name of the locale directory where the files are stored.
Administration and Usage

Use Agent Greeting with Your CTI OS Agent or Supervisor Desktop

Record a Greeting

Recording an Agent Greeting is very similar to recording a personal message for your voice mail. To record a greeting, you must be logged in to your desktop software and in the Not Ready state. To record a greeting:

Procedure

Step 1 Click the Agent Greeting Record button on your desktop.
Step 2 You may hear a brief ring tone, after which you receive voice instructions for recording a greeting. Options may include selecting a greeting type (if your contact center uses more than one greeting per agent), recording,
playing back, and confirming whether to use the new greeting. There is also an option for listening to your existing greetings.

**Step 3**

After you connect to the Record Greeting service, a dialog box containing a dial pad appears on your agent desktop. You can use the dial pad or the keypad on your phone to make your selections. (If you close the dialog box before you finish recording your greeting, you cannot re-open it; use the keypad on your hard phone to complete your recording.)

**Step 4**

To exit without recording a greeting, release the call.

The number of greetings that you need to record is determined by your contact center. It may vary depending on things like your skill group or Precision Queue membership or the time of day or day of the week. Your contact center also determines how long your greeting can be. When you are recording, if you reach the maximum recording time, you receive a notification.

---

### Delete Greeting

You cannot delete an agent greeting. However, you can record over previously recorded greetings. When you record over a greeting, the new greeting is used for the next customer call you take.

### Review Greetings

To listen to your current greetings, click the Agent Greeting Record button on your desktop and select a greeting.

### Enable or Disable Greeting Play

Your CTI desktop toolbar includes a Greeting button that you can use to turn the Agent Greeting feature on or off. There are various reasons you might want to turn off your greeting. You might want to turn off your greeting on a day when you have a cold and you are concerned that your voice does not sound like your recorded message. Or you might want to turn off a greeting that was appropriate yesterday but is not today, until you have time to go Not Ready and record a new one. Turning off Agent Greeting does not affect a greeting that is already playing to a caller.

Turning off Agent Greeting stops your greetings from playing until you manually turn it back on again, or until the next time you log in to the desktop; Agent Greeting is always automatically turned on at login.

- To turn Agent Greeting off, with Greeting enabled, click the **Greeting** button.

- To turn Agent Greeting back on, click the **Greeting** button again.

### Agent Greeting with the Outbound Agent Desktop

Agent greetings play to inbound callers only; they do not play when you make an outbound call. If you are an outbound-only agent, you can still record greetings but they do not play, even when Agent Greeting play is turned on in your desktop toolbar.
Agent Greeting During Transfers and Conferences

When you blind transfer a call to another agent, your customer hears the other agent's greeting (assuming that agent has greeting enabled). Similarly, when you conference in another agent, all parties on the call hear the other agent's greeting.

Consultative transfers work a little differently. When you place a consultative transfer, your customer does not normally hear the other agent's greeting, unless you transfer the customer while the other agent's greeting is still playing.

Agent Desktop Closes

If, while you are logged in, your CTI OS Agent Desktop software closes for any reason, when you relaunch it your Agent Greeting state is set to Enabled.

Reporting

In agent, skill group, and precision queue reports, greeting time is not specifically broken out. The period during which the greeting plays is reported as talk time. Record time is counted as an internal call by the default skill group.

Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the call to Unified CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey values in the TCD and RCD tables in the database. You can use these values to link the two legs together for reporting purposes.

Greeting Call Statistics

To view greeting call statistics, create a separate call type and associate it with the routing script that plays agent greeting. New Cisco Unified Intelligence Center templates for the agent greeting call type are created based on the data in the existing Call_Type_Real_Time and Call_Type_Interval table in the database.

Peripheral Call Types for Agent Greeting

There are two peripheral call types specific to Agent Greeting that you can use to track and report on the feature.

- Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting.
- Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

Note

Greeting recording calls made using CAD are assigned the Peripheral Call Type value 10 (AGENT_INSIDE).

Extra TCDs and RCDs are generated for the agent greeting call leg, and they can be linked to the first call leg by the same RouterCallKeyDay and RouterCallKey.
Serviceability

Serviceability for Agent Greeting includes SNMP events captured by your Network management software that indicate reasons for greeting failures and counters to track the number of failed greeting events.

Note

There is no counter for the number of failed agent greeting calls.

When system components fail, Agent Greeting may be impacted. For example, if a requested greeting audio file cannot be found for any reason, the call proceeds normally without the Agent Greeting.
Agent Request Feature Description

The Agent Request feature allows a customer to initiate a request on the web that results in a call from an agent.

Cisco SocialMiner works in a Contact Center Enterprise (CCE) solution to process the request from its inception through the delivery of the callback.

---

**Note**

Unified WIM also offers callback and delayed callback. You can use either Agent Request or Unified WIM—but not both.

---

**Important**

The Agent Request feature can be used only if the customer or a partner develops a custom application. There is sample code on the DevNet (formerly Cisco Developer Network) that you can use to understand how to start building your custom application to submit callback requests to SocialMiner.

---

**SocialMiner and Agent Request**

SocialMiner provides the Callback API used by a custom application to request a phone call from a contact center agent.

The API works in conjunction with SocialMiner callback feeds, campaigns, and notifications to pass callback requests to the contact center for routing.
The Callback API:

- Allows custom applications to initiate a callback.
- Forwards the callback request and callback details to CCE using a notification mechanism (the Connection to CCE notification type) through a Media Routing (MR) connection.
- Allows custom applications to retrieve the state of the callback as well as the estimated wait time (EWT) until an agent becomes available.
- Allows custom applications to cancel a requested callback.

The Callback API supports the use of Call variables and ECC variables for callback requests. Call variables and ECC variables send customer-specific information with the request. When you create a callback contact, the social contact associated with the callback contact includes all of the specified variables as extension fields.

**CCE and Agent Request**

CCE services in the Agent Request solution:

- Process the callback request.
- Route the callback request to an agent and place a call from the agent's phone to the customer.
- Notify SocialMiner that the agent has been selected.

**Agent Desktops and Agent Request**

Both Cisco Finesse and CTI OS support Agent Request.

**Unsupported Environments**

Agent Request is not supported:

- In a Parent/Child deployment
- With Mobile Agents
- In a hybrid deployment

**Agent Request Prerequisites**

You must install and configure SocialMiner before you can implement Agent Request. SocialMiner must be geographically co-located with one side of the Media Routing Peripheral Gateway (MR PG).

The customer or partner must build a custom application for the Agent Request feature. See Sample Code to Create Customer Callback Request, on page 39

SocialMiner is always deployed in a DMZ. You must open the port you have configured for the MR PG. See Set up the Media Routing PG and PIM, on page 34.
Agent Request Call Flow

Figure 6: Agent Request Call Flow

The flow proceeds as follows:

1. The customer application initiates an agent request by requesting a callback.
2. SocialMiner sends the request to the Media Routing PG.
   a. The Media Routing PG sends the request to the Router.
   b. The Router sends the request to the Agent PG.
   c. The Agent PG sends the request to the agent.
3. A call is initiated from the agent's phone, dialing the customer's phone number.
Agent Request Scenarios

1. From the web, the customer requests to speak to an agent.
2. The customer receives feedback that the request is accepted.
3. The customer receives feedback that the call is queued and the estimated wait time.
4. The customer receives feedback that a call is on its way.
5. The agent’s phone places an outbound call.
6. The agent is presented with call context.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The customer is available</td>
<td>The customer receives and answers the call, and speaks to the agent</td>
</tr>
<tr>
<td>The customer is busy when the callback occurs</td>
<td>The agent receives a busy tone</td>
</tr>
<tr>
<td>The customer does not answer when the callback occurs</td>
<td>The agent hears ringing</td>
</tr>
<tr>
<td>The customer cancels the callback before an agent is selected</td>
<td>There is no impact on the agent</td>
</tr>
</tbody>
</table>

Configure Unified CCE for Agent Request

The following information describes how to configure Agent Request for a Unified CCE deployment.

**Important**

Configure Unified CCE before you configure SocialMiner.

**Configuration Manager**

Use these Configuration Manager tools and procedures to configure Agent Request.
Configure Network VRU and Network VRU Script

Procedure

Step 1 In the Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU. The Network VRU is used to queue voice callback tasks if an agent is not available to handle them.

Step 2 In the Configuration Manager, use the Network VRU Script List tool to add a Network VRU Script that references the Network VRU that you configured in Step 1. The Network VRU Script is used for Estimated Wait Time.

Configure the Media Routing PG and PIM

Procedure

Step 1 In Configuration Manager, open the PG Explorer tool to configure a media routing PG.

Step 2 Create a media routing PIM and routing client for SocialMiner. Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.

Step 3 On the Peripheral tab in the PG Explorer tool, check the Enable post routing check box.

Step 4 On the Routing Client tab in the PG Explorer tool, select the Multichannel option from the Routing Type drop-down list box.

Step 5 On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.

Configure Call Type

Procedure

Open the Call Type List tool, and create a call type to handle calls from an agent request voice callback.
Configure Dialed Number/Script Selector

**Procedure**

**Step 1**  Open the Dialed Number/Script Selector List tool, and create a script selector on the routing client that you configured. SocialMiner uses this script selector to request agents for voice callback. (The script selector configured here must be the same as the one entered in the SocialMiner notification.)

**Step 2**  On the Attributes tab, select **Cisco_Voice** from the **Media routing domain** drop-down list box.

**Step 3**  On the **Dialed Number Mapping** tab, map the script selector to the call type you created.

Configure ECC Variables

**Procedure**

**Step 1**  Open the **Expanded Call Variable List** tool.

**Step 2**  Add one or more ECC Variables for the callback request.

**Note**  Arrays are not supported with the Agent Request feature.

CCE solutions support the Latin 1 character set only for Expanded Call Context variables and Call variables when used with CVP, Finesse, and SocialMiner. CCE also supports the use of multi-byte character sets in limited usage for ECC and call variables when:

- setting them in script editor using double quotes
- setting and receiving them via CTI OS desktops

Set up the Media Routing PG and PIM

**Before You Begin**

To use Agent Request, you must access Peripheral Gateway Setup to set up a Multichannel PIM that associates SocialMiner with the MR PG.

**Procedure**

**Step 1**  From Cisco Unified CCE Tools, select **Peripheral Gateway Setup**.
Step 2 On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If the PG does not exist, click Add. If it exists, click Edit.

Step 3 In the Peripheral Gateways Properties screen, click Media Routing. Then click Next.

Step 4 Click Yes at the prompt to stop the service.

Step 5 From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure with the Client Type of Media Routing as follows.
   a) Check Enabled.
   b) In the Peripheral Name field, enter MR.
   c) For Application Hostname (1), enter the hostname or IP address of SocialMiner.
   d) Make a note of the default Application Connection Port. You will use it in the CCE Configuration for Multichannel Routing for SocialMiner. The Application connection port defaults to 38001; this is the default port on which SocialMiner accepts MR connections. If you change the default port number for either side of the MR PG, you must change the second side.
   e) Leave the Application Hostname (2), field blank.
   f) Keep all other values.
   g) Click OK.

Step 6 On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded when you configured the Media Routing PG and PIM.

Step 7 Accept defaults and click Next until the Setup Complete screen opens.

Step 8 At the Setup Complete screen, check Yes to start the service. Then Click Finish.

Step 9 Click Exit Setup.

Step 10 Repeat from Step 1 for Side B.

---

**Configure SocialMiner for a Voice Callback Agent Request**

To support a callback request, SocialMiner must be configured with:

- A callback feed
- A campaign
- A Connection to CCE notification configured for the campaign mentioned above that will be triggered by incoming callback requests with a matching tag.
- CCE Configuration for Multichannel Routing must be enabled on the SocialMiner Administration tab.
Configure SocialMiner to Allow MR PG Connections

Procedure

Step 1  Click Administration.
Step 2  In the System Administration panel, click CCE Configuration for Multichannel Routing.
Step 3  Click Edit.
Step 4  Check the Enabled checkbox.
Step 5  Enter the hostnames or IP addresses of the Side A and Side B MR PG so that SocialMiner will only allow connections from those hosts.
Step 6  Update the Port (if necessary) to match the port set up on the MR PG, or leave the default. The valid range is 10000 - 65535.
Step 7  Click Save.

Create Feed

Procedure

Step 1  Click Configuration.
Step 2  On the Feeds panel, click Add.
Step 3  For Type, select Callback.
Step 4  Name the feed.
Step 5  For Reply Template, retain the default, No reply template.
Step 6  Configure the feed to automatically tag all callback requests that come in on that feed. For example, autotag with 'sendtocontactcenter'. Make a note of the tag. It is used to trigger the notification to CCE.
Step 7  Click Save.
Create Campaign

Procedure

Step 1 Click Configuration.
Step 2 On the Campaigns panel, click Add.
Step 3 Name the campaign.
Step 4 Enter an optional description.
Step 5 Make no selection in the Chat Invitation Feed drop-down list.
Step 6 Locate the Callback feed in the Available panel and move it to Selected.
Step 7 Click Save.

Create Notification

Procedure

Step 1 Click Administration.
Step 2 On the Notifications panel, click Add.
Step 3 For Type, select Connection to CCE.
Step 4 Name the notification.
Step 5 From the Campaigns drop-down list, select the campaign that you created for the callback.
Step 6 In the Tags field, enter the tag that is automatically applied to callback requests by the feed. In our example ‘sendtocontactcenter’.
Step 7 In the Dialed Number/Script Selector field, enter the dialed number string that you have configured. See Configure Dialed Number/Script Selector, on page 34.
Step 8 In the Media Routing Domain field, accept the default, Cisco_Voice.
Step 9 Click Save.

For additional SocialMiner configuration information, see the SocialMiner User Guide.

Create Script for Agent Request

This illustration shows a sample script. The key below explains the nodes.
Start node: Create the Start node by selecting a new Routing Script from the Script Editor.

Set Variable (Call.Calling Line ID) node: (optional). If required, you can set the CallingLineID (CLID/ANI) variable to implement a "dial-plan," pre-pending a set of digits to the phone number provided by the customer so that it can be correctly routed. For example, it is often necessary to add 9 to the phone number to reach an outside line. In other cases, more pre-pended digits may be required to reach the end customer.

You can also set up Unified Communications Manager Route Patterns to respond to a certain set of digits by routing the call to an outside line with a specified area code. To implement a dial-plan, add a Set Variable node before the queue, as shown in this example. In this case, a 9 is pre-pended to the customer phone number using the built-in concatenate function.

Queue to Skill Group node: The Agent Request call can be queued against one or more Skill Groups, Precision Queues, or a queue-to-agent node. In the example script, the call is queued against a single skill group.

Set Variable (Call.Estimated Wait Time) node: A customer who requests a voice callback might want to know approximately how long it will be before the call is returned. You can configure voice callback to provide an estimate of the wait time back to the customer. The estimated wait time is calculated once, when the call enters the queue. The time is not updated as the position in the queue changes.

The default estimated wait time algorithm is based on a running five minute window of the rate of calls leaving the queue. Any calls that are routed or abandoned during the previous 5 minutes are taken into account as part of the rate leaving queue. For Precision Queues, the rate leaving queue represents the rate at which calls are delivered or abandoned from the entire precision queue, not any individual recision Queue steps. The algorithm
computes the wait time for each of the queues against which the call is queued (Skill Groups or Precision Queues) and then returns the minimum estimated wait time. Queue to Agent is not supported.

While the queue builds, the small number of calls in the queue makes the estimated wait time less accurate and the value fluctuates rapidly. As the queue operates with more calls over time, the estimated wait time is more accurate and consistent. If CCE does not have enough data to calculate EWT, the callback API returns a value of -1. Customers must determine how their custom applications handle this situation.

Note that the built-in function also applies to inbound calls that queue.

Set the Call Wait time as follows:

1. From the Set Variable node, select Call from the Object type drop-down menu.
2. From the Variable drop-down menu, choose Estimated Wait Time().
   You can then work with the Formula Editor to use the default estimated wait value or create a formula and use your own value.
3. Click Formula Editor, and do either of the following:
   - To use the default estimated wait value, click the Built-In Functions tab and choose EstimatedWaitTime()
   - To create a formula and use your own value, click the Variables tab and choose an entry in the Object type list and an entry in the Object list. Then double-click a variable in the Variable list.

Run Ext Script node: Apply the Network VRU script as follows:

1. Click the Queue tab.
2. Click Run External Script.
3. Click inside the script. A Run External Script node appears.
4. Double-click the node and choose the Network VRU script from the list; then click OK.
   The call variable Estimated Wait Time now contains a value in the EstimatedWaitTime field and can be passed to peripherals.
   Note that a Run External Script node is required to send the EstimatedWaitTime to SocialMiner.

Wait node: The wait period before an agent becomes available.
End node: The script ends if no agent becomes available.

Sample Code to Create Customer Callback Request

Cisco Systems has made sample callback application code available to use as a baseline in building your own application. This sample includes retrieving and displaying the estimated wait time, assuming it has been configured in CCE. You can find the sample code on DevNet (formerly, Cisco Developer Network).

Note: You cannot copy and paste this code to achieve a working application. It is a only a guideline.

For more information about how to use the Callback API, see the SocialMiner Developer Guide.
Procedure

**Step 1** Retrieve the feed id by entering this URL in a browser:
https://<SocialMiner_Hostname_or_Ip>/ccp-webapp/ccp/feed.
In the example output below, note that the value in the <name> field is "Callback." Look for the number of the feed id identified at the end of the refURL path (in this case, it is 100000) just before the </refURL> tag. Copy this number.

```xml
<feeds>
<Feed>
<changeStamp>0</changeStamp>
<name>Callback</name>
<pushFeedURL>https://128.107.81.27/ccp/callback/feed/100000</pushFeedURL>
<refURL>https://128.107.81.27/ccp-webapp/ccp/feed/100000</refURL>
$status>1</status>
<tags>
<tag>trial</tag>
</tags>
$type>10</type>
</Feed>
</feeds>
```

**Step 2** Access the sample application from DevNet: https://developer.cisco.com/web/socialminer.

**Step 3** Enter values in the fields:
- Title: A title or subject for the callback request.
- Author: The name of the person submitting the callback request.
- Phone: The phone number to call back.
- Feed Id: The value from the refURL above.

**Step 4** Click **Call me back**.

---

**Agent Request Reporting**

Cisco Unified Intelligence Center CCE reports include data for Agent Requests.

**Note**
Agent requests that fail before being routed to CCE will not be included in the CCE solution-level reports. The SocialMiner search function can be used to identify these requests.

**Call Type and Call Type Skill Group Metrics**

- **Calls Offered** — Incremented when Call Type is entered (through Script Selector or Call Type node).
- **Calls Abandoned in Queue** — Incremented when a Queued Callback request is canceled by the customer prior to when an Agent is selected to handle the Voice Callback call.
- **Calls Answered** — Incremented if the call is placed from the agent and represents work accepted by the agent.
• **Calls Handled** — Incremented if the customer answers the call. Calls Answered minus Calls Handled indicates how many calls failed to reach the intended customer.

• **Service Level Offered** — Incremented for all routed calls, including voice callback calls initiated through the agent request API.

• **Service Level Calls** — Incremented if the call is presented to the agent within a service level.

• **Answer Intervals (1 - 10)** — The appropriate bucket is incremented based on how long the call was in the queue.

**Skill Group Metrics**

Call Type Skill Group and Skill Group metrics are not counted in the same way. The skill group metric treats each call as agent-initiated; therefore, Calls Answered and Calls Handled are not incremented. AgentOutCallsTime, AgentOutCalls, AgentOutCallsTalkTime, AgentOutCallsOnHold, and AgentOutCallsOnHoldTime are incremented.

**Agent Real Time**

The direction in the Agent Real Time table is listed as Outbound.

**Termination Call Detail**

For custom reporting, the Termination Call Detail records contain a PeripheralCallType of 41-Voice Callback. Calls which do not successfully connect to a customer have a call disposition of **10 - Disconnect/Drop no answer**. This includes agent request calls to busy numbers.
Mobile Agent

Capabilities

Cisco Unified Mobile Agent description

Cisco Unified Mobile Agent (Unified Mobile Agent) enables an agent using any PSTN phone and a broadband VPN connection (for agent desktop communications) to function just like an agent sitting in a formal call center and using a Cisco IP Phone that is monitored and controlled by Unified CM JTAPI.

Unified Mobile Agent for Unified CCE/Unified CCH supports call center agents using phones that are not directly controlled by Unified CCE/Unified CCH. You can physically locate a Mobile Agent:

- Outside the contact center, by using an analog phone in the home or a cell phone.
- By using an IP phone connection that is not CTI-controlled by Packaged CCE, Unified CCE, or by an associated Unified Communications Manager.
- By any voice endpoints on any ACD (including those on other Unified Communication Managers) that are reachable by a SIP trunk from the contact center Unified Communication Manager.

In addition, a Unified Mobile Agent can be available through different phone numbers at different times; the agent enters the phone number at login time. In other words, the agent can access Unified Mobile Agent using
any phone number, as long the agent can dial that number through the Unified Communications Manager dial plan.

**Figure 7: Agent at home using Unified Mobile Agent**

With Cisco Unified Mobile Agent, contact centers can:

- Add/enable temporary staff during seasonal high call volume who can be brought on line with reduced startup costs
- Provide agents with the flexibility to work from home with similar quality, function, performance, convenience, and security as are available in the corporate headquarters contact center
- Allow agents to use the device they are most comfortable with, which improves agent productivity, helps to retain agents, and reduces training costs
- Hire skilled employees where they live and integrate remote workers into geographically dispersed teams with access to equivalent corporate applications

The sections that follow highlight some of the benefits of Unified Mobile Agent, and describe its features.

**Related Topics**

- Important considerations, on page 51
**Unified Mobile Agent extends Unified CCE/Unified CCH capabilities**

Prior to Unified Mobile Agent, Unified CCE/CCH used a JTAPI interface to Unified CM to connect customer calls arriving on a voice gateway to an agent's IP phone. Unified Mobile Agent extends the Unified CCE/Unified CCH architecture by enabling it to connect customer calls to an agent phone that is not controlled by Unified CCE/Unified CCH.

Unified Mobile Agent uses a pair of CTI ports that function as proxies for the Mobile Agent phone and the caller phone. Two CTI ports (local and remote) are required for every logged-in Mobile Agent, and the two CTI ports take the place of the Cisco IP Phone monitored and controlled by Unified CM JTAPI. The local CTI port DN is used by the agent at login and is where callers are routed when this agent is selected. The remote CTI port calls the agent either at login for a nailed (permanent) connection or upon being selected for a call by call connection.

Cisco Unified Contact Center functionality remains intact whether an agent is mobile or local:

- Mobile Agents have the same capabilities and functionality that local agents have.
- Mobile Agents do not need any specialized equipment; they can receive calls on an analog or cellular phone.
- Unified Mobile Agent supports Cisco CTI OS Agent Desktop, Cisco Agent Desktop (CAD), and Cisco Finesse.
- Mobile Agent activity is recorded in the same contact center reports as local agent activity.
- Mobile Agent CTI and application data uses the same security mechanisms as local agent data.

**Unified Mobile Agent provides agent login flexibility**

Agents, at various times, can be either local agents or Mobile Agents, depending on how they log in. Regardless of whether agents log in as local or Mobile Agents, the skill groups that they belong to do not change. In addition, because agents are chosen by existing selection rules and not according to how they are connected, the same routing applies regardless of how the agents log in. In other words, if you want to use the scripting environment to control routing depending on whether agents are local or mobile, you need to assign the agents to different skill groups and design the script accordingly.

**Connection modes**

Cisco Unified Mobile Agent allows system administrators to configure agents to use either call by call dialing or a nailed connection, or the administrator can configure agents to choose a connection mode at login time.

Mobile Agents are defined as agents using phones not directly controlled by Unified CC, irrespective of their physical location. (The term local agent refers to an agent who uses a phone that is under control of Unified CC, irrespective of physical location.)

You can configure Mobile Agents using either of two delivery modes:

- **Call by Call**—In this mode, the Mobile Agent's phone is dialed for each incoming call. When the call ends, the Mobile Agent's phone is disconnected before being made ready for the next call.
- **Nailed Connection**—In this mode, the agent is called at login time and the line stays connected through multiple customer calls.
The administrator can select the Agent chooses option, which allows an agent to select a call delivery mode at login.

### Call by Call

In a call by call delivery mode, the Mobile Agent's phone is dialed for each incoming call. When the call ends, the Mobile Agent's phone disconnects before it is made ready for the next call.

The call by call call flow works as follows:

1. At login, the agent specifies an assigned extension for a CTI port.
2. A customer call arrives in the system and, through normal Unified ICM configuration and scripting, is queued for a skill group or an agent. (This is no different than existing processing for local agents.)
3. The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and configured for either call by call or Agent chooses mode, the router uses the extension of the agent's CTI port as a label.
4. The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but do not answer the call.
5. A call to the agent is initiated on another CTI port chosen from a preconfigured pool. If this call fails, Redirect on No Answer processing is initiated.

In call by call mode, the Answer Wait Time is 3 to 15 seconds longer than in a local agent inbound call scenario. Specify a Redirect on No Answer setting large enough to accommodate the extra processing time.

6. When the agent takes the remote phone off-hook to answer the call, the system directs the customer call to the agent's call media address and the agent's call to the customer's call media address.
7. When the call ends, both connections are terminated and the agent is ready to accept another call.

In call by call delivery mode, callers often perceive a longer ring time compared to nailed connection delivery mode. This is because callers hear the ringtone for the duration of the call flow; ringing stops only after the agent answers. From the Unified CCE reporting perspective, a Mobile Agent in call by call delivery mode has a longer Answer Wait Time for the same reason.

### Related Topics

Configure Agent Desk Settings with Configuration Manager, on page 66
Nailed connections

In nailed connection delivery mode, the agent is called once, at login, and the phone line remains connected through multiple customer calls. See the following figure.

Figure 8: Nailed Connection Call Flow

The nailed connection call flow works as follows:

1. At login, the agent specifies an assigned extension for a CTI port from a pool.
2. A call to the agent is initiated on another CTI port chosen from a preconfigured pool. The agent answers the call. (The agent must answer this setup call to complete the connection and finalize the login procedure.)
3. A customer's call arrives in the system and, through normal Packaged CCE configuration and scripting, is queued for a skill group or an agent. (This is no different than existing processing for local agents.)
4. The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and configured for either nailed connection or Agent chooses mode, the router uses the extension of the agent's CTI port as a label.
5. The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but does not answer the call.
6. The agent desktop indicates a call is ringing and the agent clicks Answer.
7. When the agent indicates that they will answer the phone, the system directs the customer call to the agent's call media address and the agent call to the customer's call media address.
8. When the call ends, the customer connection is terminated and the agent state is set to Ready.

Connect Tone

The Connect Tone feature in the nailed connection mode enables the system to play a tone to the Mobile Agent through the agent's headset to let the agent know when a new call is connected. In the nailed connection mode, you can configure an audible connect tone in addition to a call arrival notice (on the desktop only).

Connect Tone is particularly useful when Auto Answer is enabled or the agent is an Outbound agent. Here are its features:

- An audible tone (two beeps) is sent to the Mobile Agent headset when the call to the nailed connection Mobile Agent is connected. It is a DTMF tone played by Unified CM and cannot be modified.
The Connect Tone plays only when the nailed connection Mobile Agent receives a call, as in the following examples:

- The agent receives a consultation call.
- The agent receives an outbound call.

The Connect Tone does not play when the nailed connection Mobile Agent initiates a call, as in the following examples:

- The agent makes a call.
- The agent makes the consultation call.
- Outbound direct preview call is made.
- Supervisor barge-in call is made.

Related Topics

Enable Mobile Agent Connect Tone, on page 73

Agent Greeting and Whisper Announcement

**Note**

You can use Agent Greeting for Mobile Agents only with parent/child deployments that are approved by Cisco Assessment-to-Quality (A2Q) with Design Mentoring Services (DMS).

Agent Greeting

You can use the Agent Greeting feature to record a message that plays automatically to callers when they connect to you. Your greeting message can welcome the caller, identify you, and include other useful information.

Limitations

The following limitations apply to the Agent Greeting feature for Mobile Agents.

- If a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent Greeting before the call ends. This applies for both call by call and nailed-up calls.

**Note**

In the Agent Greeting Call Type Report, this call does not appear as a failed agent greeting call.

- A supervisor cannot barge in when an Agent Greeting is playing.
- If a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting plays for a Mobile Agent, the call fails.
- If a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent Greeting before the call ends.
In the Agent Greeting Call Type Report, this call does not appear as a failed agent greeting call.

- If a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting plays for a Mobile Agent, the call fails. This applies for both call-by-call and nailed-up calls.

For more information about Agent Greeting, see Capabilities, on page 1.

**Whisper Announcement**

With Whisper Announcement, agents can hear a brief prerecorded message just before they connect with each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ringtone patterns) while the announcement plays. The announcement can contain information about the caller, such as language preference or customer status. This information helps the agent prepare for the call.

**Configuration requirement**

For the Whisper Announcement feature for Unified Mobile Agents, you require a Media Termination Point (MTP) resource on an incoming SIP device.

For more information about Whisper Announcement, see Whisper Announcement Capabilities, on page 103.

**Related Topics**

Media Termination Points configuration, on page 68

---

### Feature requirements

#### Hardware and software requirements

Hardware and software requirements for the Unified Mobile Agent are identical to those of Unified CCE. See the Design Guide for a quick reference on configuration limits and scalability constraints. See Virtualization for Unified CCE and the Compatibility Matrix for Unified CCE pages on the DocWiki.

#### Phone requirements

A Unified Mobile Agent can use an analog, digital, or IP phone to handle calls.

#### Conference requirements

To use Agent Greeting for Mobile Agents, you must configure external conference-bridge (hardware) resources. To estimate the number of required resources, you can use the following formula:

\[
\text{Number of conference bridge resources} = \text{Mobile Agent call rate} \times \text{Average greeting time (in seconds)}
\]

For information about configuring external conference-bridge resources, see the dspfarm profile 1 for conference configuration section in the sample configuration gateway, listed in Media Termination Points configuration, on page 68.
For information about using Agent Greeting from CTI OS Agent Desktop, see the note in Verify login, on page 75.

CTI port requirements

You need two CTI ports (local and remote) for every logged-in Mobile Agent.

Unified Mobile Agent uses Unified CM CTI Port as a proxy for the agent's phone. When this proxy is set up, whenever a Mobile Agent is selected to handle a customer call, the following happens:

- The call is directed to the CTI port extension.
- Unified CCE/Unified CCH, using the JTAPI Gateway, intercepts the call arriving on the CTI Port and directs Unified CM to connect the call to the Mobile Agent.

Unified Mobile Agent requires that maximum number of calls is set to 2 and busy trigger is set to 1.

For Unified Mobile Agent to work properly, you must configure two CTI ports:

- One port to serve as the agent's virtual extension.
- The other port to initiate calls to the agent.

One port is required per Mobile Agent. You must assign these CTI ports to the Unified ICME application. The ports are recognized by Unified ICME when receiving the Unified CM configuration.

Related Topics

Configure Unified CM CTI port Pools for Unified Mobile Agent, on page 63

Supported Unified CCE/Unified CCH features

The following features are supported:

- Unified CCE support temporary uninstallation while preserving Mobile Agent data.
  For more information about temporary uninstallation, see the Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted
- Mobile Agents can participate in outbound campaigns, but they must use a nailed-up connection for all outbound dialing modes.
- Unified Mobile Agent supports Redirect on No Answer (RONA). If the Mobile Agent fails to answer, the agent is made Not Ready, and the call is redirected to a RANA DN route point.
- Unified Mobile Agent supports silent monitoring in CTI OS and in Cisco Agent Desktop (CAD)
- Unified Mobile Agent supports the same call control capabilities as Unified CCE/Unified CCH (answer, hold, transfer, and so on). All call control is done through the CAD.
- Unified Mobile Agent supports G.711A-law, G.711u-law, and G.729 codecs.
- There is no direct interaction between Unified Mobile Agent and multichannel applications. Email and Chat are IP applications that continue to operate normally, assuming the Mobile Agent has a desktop with enough bandwidth on the broadband connection to support them.
Unified Mobile Agent supports Cisco Unified Customer Voice Portal (Unified CVP) and Cisco Unified IP-IVR (Unified IP IVR).

Related Topics
Silent monitoring, on page 53

Fault tolerance support

Fault tolerance for the Unified Mobile Agent follows the behavior of Unified CCE/Unified CCH:

- The JTAPI Gateway, IPCC PIM, and CTI components record key events related to Unified Mobile Agent as part of their normal logging.

- As with standard Unified CC calls, if a Peripheral Gateway (PG) component such as the JTAPI Gateway fails, the phone call is not lost, but subsequent call control (transfer, conference, or hold) might not be possible after a failover. The Mobile Agent is notified of a failure (on the desktop), but they must log in again after a Unified CM or Unified ICM failure occurs.

- Where CTI data is delivered for screen pops, CTI data is preserved.

Unified Mobile Agent can experience many of the same failure cases as Unified CC:

- Side A/B failure
- IVR failure
- Unified CM failure
- CTI server failure

There are also some failure cases that are unique to Unified Mobile Agent:

- A situation where a Mobile Agent is using a cellular phone and the connection is dropped due to non-availability of a signal, is deemed as external failure. The agent must call back and log-in again.

- If a Mobile Agent's phone line disconnects while using nailed connection mode, the agent must log in again to receive new calls.

Related Topics
Failover, on page 51

Important considerations

Before you proceed, consider the following Unified Mobile Agent limitations and recommendations:

Failover

- During failover, if an agent in call by call mode answers an alerting call, the call can drop. This occurs because the media cannot be bridged when there is no active PG.
• During a prolonged Peripheral Gateway (PG) failover, if an agent takes call control action for a Unified Mobile Agent-to-Unified Mobile Agent call, the call can drop. This occurs because the activating PG might not have information for all agents and calls at that point.

• Unified CM failover causes a Mobile Agent call to be lost because call preservation on H.323 devices is not supported.

• If a call by call Mobile Agent initiates a call (including a supervisor call) and does not answer the remote leg of the call before PG failover, the call fails. The agent must disconnect the remote agent call leg and reinitiate the call.

**Performance**

• Mobile Agent call processing uses significantly more server resources and therefore reduces the maximum number of supported agents on both Unified CM and the Unified ICM Agent PG.

  For more information about sizing Mobile Agents, see the *Cisco Unified Contact Center Enterprise Design Guide*.

• Because Unified Mobile Agent adds processing steps to Unified CCE/Unified CCH default functionality, Mobile Agents might experience some delay in screen popup windows.

• From a caller's perspective, the call by call delivery mode has a longer ring time compared with the nailed connection delivery mode. This is because Unified CCE/Unified CCH does not start to dial the Mobile Agent's phone number until *after* the call information is routed to the agent desktop. In addition, the customer call media stream is not connected to the agent until after the agent answers the phone.

  The caller hears a repeated ring tone while Unified CCE/Unified CCH makes these connections.

**Codec**

The codec settings on the Peripheral Gateway and Voice Gateway must match. Perform the following procedure:

1. Launch the Peripheral Gateway Setup.

2. In the Peripheral Gateway Component Properties, select the UCM PIM and click **Edit**.
3 In the CallManager Parameters section, select the appropriate codec from the Mobile Agent Codec drop down list.

Figure 9: Mobile Agent Codec Selection

Silent monitoring

Unified Mobile Agent provides the following silent monitoring support:

- Mobile Agent supports CTI OS server-based silent monitoring only. Unified CM-based silent monitoring is not supported.
- Unified Mobile Agent requires that caller and agent voice gateways be on separate devices if silent monitoring is to be used.
- Unified Mobile Agent does not support desktop monitoring.
- Whenever silent monitoring is used on Unified Mobile Agent, caller and agent voice gateways must be on separate devices. Similarly, if MTP is enabled when silent monitoring is used, MTP resources for caller and agent must also be on separate devices.

Note

For more information about Silent Monitoring requirements in a Unified Mobile Agent environment, see CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.
Mobile Agent scalability

Mobile Agent scalability may be contingent on specific Unified CM versions. For more information, see the Cisco Unified Contact Center Enterprise Design Guide at http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_implementation_design_guides_list.html.

Unsupported features

The following is a list of unsupported features for Mobile Agent:

- Web Callback
- Blended Collaboration
- Unified CM-based Silent Monitoring
- Agent Request

Unified Mobile Agent call flows

This section provides sample Unified Mobile Agent call flows for:

- Inbound calls
- Local consultation calls
- Remote consultation calls
- Remote conference calls

In all Unified Mobile Agent call flows, the JTAPI Gateway maintains the signaling association between the inbound and outbound calls and, if necessary, performs further operations on the call. JTAPI Gateway, however, does not terminate media; it uses CTI to deliver the customer call from the inbound gateway port to the outbound gateway port.

This means that a Mobile Agent must use an agent desktop application to log in, change agent state, log out, and perform call control.

About figures in this section

The figures in this section:

- Show a caller and a Mobile Agent in a cellular network. However, the same concepts apply whether the Mobile Agent is using an enterprise desk phone, an IP Phone spanning another Unified CM cluster, standard analog phone, or a third-party ACD phone.
- Focus solely on call media flow; a Mobile Agent must use a CTI Desktop with broadband access to perform agent state and call control.
- Show only a sampling of the call flows possible with Unified Mobile Agent.
Inbound call flow

The following figure shows an inbound call flow.

*Figure 10: Mobile Agent inbound call flow*

---

**Note**

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes an inbound call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. A customer call arrives at the Unified CC.
3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.
4. The Router passes the call to the *local* CTI Port of a Mobile Agent.
5. The JTAPI Gateway places a call on a *network* CTI port to the agent's cell phone.
6. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the call from the inbound (caller) gateway port to the outbound (agent) gateway port.
Local consult calls

The following figure shows a consult call flow between a Mobile Agent and a local agent.

Figure 11: Mobile Agent consult call flow

Note

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes a local consult call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.

6. The Mobile Agent places the customer call on hold and consults a local Unified CCE/Unified CCH agent.
7 The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the call from the IP hard phone to the outbound gateway port.

**Remote consult calls**

The following figure shows a remote consult call flow between two Mobile Agents.

*Figure 12: Mobile agent remote consult call flow*

---

**Note**

Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring is required.

The following describes a remote consult call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.
5 The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.
6 Mobile Agent 1 puts the customer call on hold and consults Mobile Agent 2.
7 The JTAPI Gateway uses the network CTI port of Mobile Agent 1 and the network CTI port of Mobile Agent 2 to stream the media for the call from the outbound gateway port on Agent Gateway 1 to the outbound gateway port on Agent Gateway 2.

Remote conference calls

The following figure shows a remote conference call flow between two Mobile Agents.

![Remote conference call flow diagram]

**Figure 13: Mobile Agent remote conference call flow**

**Note**

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes a remote conference call flow:

1 The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
- Launching the agent desktop interface and logging in to the CTI server with their remote phone information
- Entering the Ready mode

2 A customer call arrives at the Unified CC.
3 The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.
4 The Router passes the call to the local CTI Port of a Mobile Agent.
5 Unified CM redirects the media stream 1 from inbound gateway on the Caller Gateway to the conference bridge during call merging process.
6 The JTAPI Gateway uses local and network CTI ports of Mobile Agent 1 to loop the Media Stream 2 for the call from the outbound gateway port on the Agent Gateway 1 to the conference bridge.
7 The JTAPI Gateway uses local and network CTI ports of Mobile Agent 2 to loop the Media Stream 3 for the call from the outbound gateway port on the Agent Gateway 2 to the conference bridge.

**Outbound Option call flow**

The following figure shows an Outbound Option call flow between a customer and a Mobile Agent.

---

**Note**

Unified Mobile Agent supports Outbound Option calls in nailed connection delivery mode only.

---

**Figure 14: Mobile Agent outbound call flow**
The following describes an Outbound Option call flow:

1. The Mobile Agent becomes available to answer calls by:
   • Logging in to the corporate domain using VPN over the ADSL/Cable connection
   • Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   • Entering the Ready mode

2. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

3. Outbound Option dials the customer number and, after reaching a live customer, the Dialer redirects the customer call to the local CTI Port of an Outbound Option Mobile Agent.

4. The JTAPI Gateway places a call on a network CTI port to the agent's cell phone.

5. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the call from the inbound gateway port to the outbound gateway port.

**Unified Mobile Agent reporting**

Unified Mobile Agent-specific call data is contained in the following Cisco Unified Intelligence Center reports: Agent Team Historical, Agent Real Time, and Agent Skill Group Historical. These "All Field" reports contain information in multiple fields that show what kind of call the agent is on (nonmobile, call by call, nailed connection) and the Unified Mobile Agent phone number.

Notes about Mobile Agents and reporting:

• The Mobile Agent must be logged in through the agent desktop for call data to be recorded in Unified CC reports.

• Service level for Mobile Agent calls might be different than local agent calls, because it takes longer to connect the call to the agent.

For example, a call by call Mobile Agent might have a longer Answer Wait Time Average than a local agent. This is because Unified CCE/Unified CCHdoes not start to dial the Mobile Agent phone number until after the call information is routed to the agent desktop. In addition, the customer call media stream is not connected to the agent until after the agent answers the phone.

For more information about Unified Mobile Agent fields in the database schema, see *Database Schema Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.*
Initial Setup

Summary of Unified Mobile Agent system configuration tasks

This section describes the configuration tasks specific to Unified Mobile Agent configuration. It does not describe Unified CCE/Unified CCH. The following table describes system configuration tasks for Unified Mobile Agent.

Note

For more information about installing and configuring Unified CCE/Unified CCH, see the Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Unified CM CTI Port pools</td>
<td>Unified CM CTI port configuration and mapping for Unified Mobile Agent, on page 61</td>
</tr>
<tr>
<td>Configure Unified CM Call Duration Timer</td>
<td>Maximum Call Duration Timer Configuration, on page 65</td>
</tr>
<tr>
<td>Configure Agent Desk Settings</td>
<td>Agent Desk Setting configuration for Unified Mobile Agent, on page 65</td>
</tr>
<tr>
<td>Configure Devices</td>
<td>Device configuration for Unified Mobile Agent, on page 67</td>
</tr>
<tr>
<td>Configure CTI OS</td>
<td>Cisco CTI OS configuration for Unified Mobile Agent, on page 67</td>
</tr>
<tr>
<td>Configure Media Termination Points</td>
<td>Media Termination Points configuration, on page 68</td>
</tr>
</tbody>
</table>

Unified CM CTI port configuration and mapping for Unified Mobile Agent

This section describes the CTI Port Pool configuration tasks specific to Mobile Agent Option configuration. It does not discuss installation or configuration of Unified CCE.

Note

For more information about installing and configuring Unified CM with Unified CCE, see Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted.

Unified Mobile Agent must have two CTI ports configured on Unified CM:

- A local CTI port, which Unified Mobile Agent uses as the agent's virtual extension.
- A remote CTI port, which Unified Mobile Agent uses to initiate a call to the Mobile Agent's phone.
Naming Conventions for Local and Network Ports

- The local port must begin with the string LCP.
- The remote port must begin with the string RCP.
- The remaining characters in the device names for the LCP and RCP pair must match. For example, an LCP port named LCP0000 has a corresponding RCP port named RCP0000.
- Although not required, for best practices, use the following naming convention:
  - For a local CTI Port pool name, configure a name in the format LCPxxxxFyyyy, where LCP identifies a local CTI Port Pool, xxxx is the peripheral ID for the Unified CM PIM, and yyyy is the number of local CTI Port.
  - Example: LCP5000F0000 represents CTI Port: 0 in a local CTI Port pool for the Unified CM PIM with the peripheral ID 5000.
  - For a network CTI Port pool name, use the same format, except substitute RCP as the first three characters.

Note: While you do not require a naming convention, the substrings identifying the Unified CM PIM peripheral ID and the CTI Port must match for each local/network pair.

CTI Port configuration consists of the following steps:

1. Add the CTI port as you would for an IP Phone.
2. Use the naming convention described above to map the local and network CTI ports.

Note: Each local CTI port must have a corresponding network CTI port.

3. Add a directory number for the local CTI port (that is, the agent's virtual extension).
4. Map the local and network CTI ports with the PG user.

Music on Hold design

If you want callers to hear music when a Mobile Agent places the caller on hold, you must assign Music on Hold (MoH) resources to the ingress voice gateway or trunk that is connected to the caller (as you do with traditional agents). In this case, the user or network audio source is specified on the local CTI port configuration. Similarly, if a Mobile Agent must hear music when the system puts the agent on hold, you must assign MoH resources to the ingress voice gateway or trunk that is connected to the Mobile Agent. In this case, the user or network audio source is specified on the remote CTI port configuration.

Do not assign MoH resources to local ports and remote CTI ports, because it might affect the system performance.

If a remote Mobile Agent calls over a nailed connection and if there is no active call to the agent, the agent is put on hold. Enable MoH to the Mobile Agent phone for nailed connection calls. If MoH resources are an issue, consider multicast MoH services.
If a remote Mobile Agent calls over a nailed connection, and if MoH is disabled, the hold tone plays to the agent phone during the hold time. This depends on the call processing agent that controls the Mobile Agent remote phone. For Unified CM, the hold tone is enabled by default (it is similar to the Mobile Agent connect tone). Because the hold tone is similar to the connect tone, it is difficult for the agent to identify if a call arrived from listening to the Mobile Agent connect tone. The hold tone prevents the agent from hearing the connect tone.

Therefore, disable the hold tone by changing the setting of the Tone on Hold Timer service parameter to 0. For more information about setting this parameter, see the Unified CM product documentation available at: http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html.

### Configure Unified CM CTI port Pools for Unified Mobile Agent

Perform the following steps to configure CTI Ports.

**Procedure**

**Step 1** In Unified CM Administration, select **Device > Phone**.

**Step 2** Click **Add a New Phone**.

**Step 3** From Phone Type, select **CTI Port**.

**Step 4** Click **Next**.

**Step 5** In **Device Name**, enter a unique name for the local CTI Port pool name; click **OK** when finished.

Using the naming convention format LCPxxxxyyyy:

- LCP identifies the CTI Port as a local device.
- xxxx is the peripheral ID for the Unified CM PIM.
- yyyy is the local CTI Port.

The name LCP5000F0000 would represent CTI Port: 0 in a local CTI Port pool for the Unified CM PIM with the peripheral ID 5000.

The name LCP0000 represents the local port.

**Step 6** In **Description**, enter text that identifies the local CTI port.

**Step 7** Use the **Device Pool** drop-down list to choose the device pool to which you want to assign the network CTI port pool. (The device pool defines sets of common characteristics for devices.)

**Step 8** Click **Save**.

**Step 9** Highlight a record and select **Add a New DN**.

**Step 10** Add a unique directory number for the CTI port you just created.

**Step 11** In **Maximum Number of Calls**, enter **2**.

**Step 12** In **Busy Trigger**, enter **1**.

**Step 13** When finished, click **Save**, and click **Close**.

**Step 14** Repeat the preceding steps to configure the network CTI port pool.

In **Device Name**, using the naming convention format RCPxxxxyyyy, where:

- RCP identifies the CTI port as the Remote CTI port where the call between the agent's remote device and the Unified CM Port is nailed up at agent login time.
• xxxx is the peripheral ID for the Unified CM PIM.

• yyyy is the network CTI port.

The name RCP5000F0000 represents CTI Port: 0 in a network CTI Port pool for the Unified CM PIM with the peripheral ID 5000.

**Step 15** In Description, enter text that identifies the network CTI port pool.

**Step 16** Use the Device Pool drop-down list to choose the device pool to which you want to assign the network CTI port pool. (The device pool defines sets of common characteristics for devices.)

**Step 17** Click Save.

**Step 18** Highlight a record and select Add a New DN.

**Step 19** Add a unique directory number for the CTI port you just created.

**Step 20** When finished, click Save, and click Close.

---

**Map local and remote CTI ports with Peripheral Gateway user**

After you define the CTI Port pool, you must associate the CTI Ports with PG users.

**Procedure**

**Step 1** In Unified CM Administration, select Application User.

**Step 2** Select a username and associate ports with it.

**Step 3** When finished, click Save, and then click Close.

**Note** If CTI ports for Unified Mobile Agent are disassociated at the Unified CM while a Mobile Agent is on an active call, the call can drop.

---

**Create Agent-Targeting Rules for LCP Ports**

You must create agent-targeting rules for your LCP ports in order to log in as a mobile agent.

Perform the following steps:

**Procedure**

**Step 1** Open Configuration Manager.

**Step 2** Within Configuration Manager, open the Agent Targeting Rule tool.

**Step 3** On the Agent Targeting Rule tool screen, select your existing agent-targeting rules.

**Step 4** In the Extension Ranges section, add the range of line numbers for the LCP ports that you are using for your mobile agents.

**Example:**
Maximum Call Duration Timer Configuration

By default, Mobile Agents in nailed connection mode log out after 12 hours. This happens because a Unified CM Service Parameter—the Maximum Call Duration Timer—determines the amount of time an agent phone can remain in the Connected state after login.

If you anticipate that nailed connection agents in your Unified Mobile Agent deployment will be logged on longer than 12 hours, use the following instructions to either:

- Increase the Maximum Call Duration Timer setting.
- Disable the timer entirely.

Configure Maximum Call Duration Timer

This procedure applies only to Unified Mobile Agent deployments where agents logged in to nailed connection mode are to remain connected longer than 12 hours. Also, if your Mobile Agent deployment uses intercluster trunks, you must perform the following steps on both local and network Unified CM clusters.

Procedure

Step 1
In Unified CM Administration, choose System > Service Parameters.

Step 2
In the Server drop-down list, choose a server.

Step 3
In the Service drop-down list, choose a server.

The Service Parameters Configuration window appears.

Step 4
In the Cluster-wide Parameters section, specify a Maximum Call Duration Timer setting. The default is 720 minutes (12 hours); the maximum setting allowed is 35791 minutes.

Note
To disable the timer, enter 0.

Step 5
Click Save.

Agent Desk Setting configuration for Unified Mobile Agent

This section describes Agent Desk Settings you must modify to accommodate Unified Mobile Agent features.

You can configure Agent Desk Settings through the PCCE Administration tool.
Configure Agent Desk Settings with Configuration Manager

This section describes Agent Desk Settings configuration settings you should specify in Unified ICM Configuration Manager to accommodate Unified Mobile Agent features.

The following instructions describe how to configure one Agent Desk Setting. Repeat this process for each different Agent Desk Setting in your deployment.

**Procedure**

**Step 1** From the Unified ICM Configuration Manager, choose Configure ICM > Enterprise > Agent Desk Settings List.
The Unified ICM Agent Desk Settings List dialog box opens.

**Step 2** From the Unified CCE Administration, choose Manage > Desk Settings.

**Step 3** Click Retrieve.

**Step 4** Click Add.

**Step 5** Fill in the following Attributes tab information, making sure to include settings for the following fields and check boxes:

- **Ring no answer time.** The system allows a call to ring at the agent's station before redirecting the call. This can be from 1 to 120 seconds.
  
  **Note** If you use call by call mode, the answer wait time will be longer than in a local agent inbound call scenario, so specify a value in this field to accommodate the extra processing time.

- **Logout non-activity time.** The number of seconds of agent inactivity while in the not ready state before the system logs out the agent. A blank entry disables the timer.

- **Cisco Unified Mobile Agent** (check box). Enables the Mobile Agent feature so that the agent can log in remotely and take calls from any phone.

- **Mobile Agent mode.** Select how call connections are made to the Mobile Agent's phone:
  
  - **Agent chooses.** Agent selects call by call or nailed connection at login.
  
  - **Call by call.** Agent's phone is dialed for each incoming call. When a call ends, the connection is terminated before the agent is made ready for next call.
  
  - **Nailed connection.** Agent is called once, at login. The line stays connected through multiple customer calls.

**Step 6** Check the Enable Mobile Agent check box. This enables the Mobile Agent feature so that the agent can log in remotely and take calls from any phone.

**Step 7** Click Save.

**Note** For more information about configuring Agent Desk Settings in PCCE/Unified CCH, see Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted.
Related Topics

Prevent Duplicate Logins to the Same AgentID, on page 68

Device configuration for Unified Mobile Agent

Use the Agent Targeting Rules (ATR) mechanism described in the *Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted* to configure a device as you would for a phone, but using the LCP Port in place of the agent's phone extension.

Cisco CTI OS configuration for Unified Mobile Agent

This section describes information about CTI OS configuration settings that you need to know after initial installation of a Mobile Agent-enabled CTI OS Server.

Note

For more information about installing and configuring CTI OS Server, see *CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*.

CTI OS installation and Unified Mobile Agent

Note

Running the CTI OS server installer is not the same as running CTI OS installer from the CTI OS bin directory.

To configure Mobile Agent, run the CTI OS server installer from your installation media. This first installer updates CTI OS server. Then run the CTI OS installer from the CTI OS bin directory. This second installer allows you to configure Mobile Agent. Use both installation procedures to configure any new feature made available in a maintenance release. The Unified Mobile Agent feature is enabled for the CTI Desktop (from the CTI OS bin directory).

During the peripheral identification step of CTI OS Server installation, follow these steps:

1. Click Yes to stop the service and to acknowledge the license agreement.
2. Select CTIOS server from CTI OS Instance and click Edit.
3. Click Next to navigate to Peripheral Identifier.
4. Check the Enable Mobile Agent checkbox.
5. Select the appropriate call delivery mode for your deployment.

Note

For Mobile Agents that handle outbound campaigns, you must select Nailed connection.

6. Click Save.
Call delivery mode and agent profiles

- The call delivery mode selected during CTI OS Server installation enables CTI OS to send an agent profile to each desktop client for that mode.
- The call delivery mode the agent uses at login must match the mode that is configured for the agent in the Agent Desk Setting.
- Rerunning the CTI OS installation and selecting a different Mobile Agent mode overwrites the existing profile.

Prevent Duplicate Logins to the Same AgentID

In the default Installation, the CTI OS system does not prevent duplicate logins. If you want to change the default, you must make the following change in the Windows Registry for the key RejectIfAlreadyLoggedIn.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>On the CTI OS Server, open the Registry Editor (regedit.exe).</td>
</tr>
<tr>
<td>Step 2</td>
<td>Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ctios\CTIOS &lt;InstanceName&gt;\ CTIOS1\ EnterpriseDesktopSettings\All Desktops\ Login \ConnectionProfiles \Name&lt;YourConnectionProfileName&gt;\RejectIfAlreadyLoggedln . The Edit DWORD Value dialog box appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Value data: field, enter 1 and click OK.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Exit the Registry Editor to save the change, and reboot your computer.</td>
</tr>
</tbody>
</table>

Optional, you can configure the CTI OS CTI Driver key IdleTimeout to the same value as the Unified ICM Agent Desk Settings Logout non-activity time value.

Related Topics

Configure Agent Desk Settings with Configuration Manager, on page 66

Media Termination Points configuration

If you use SIP trunks, you must configure Media Termination Points (MTPs). You must also configure MTPs if you use TDM trunks to create an interface with service providers.

Additionally, MTPs are required for Mobile Agent call flows that involve a Cisco Unified Customer Voice Portal (CVP) solution. Because in DTMF signaling mode the Mobile Agent uses out-of-band signaling, whereas Unified CVP supports in-band signaling, the conversion from out-of-band to in-band signaling requires an MTP resource.
MTPs are available in the following forms, but not all are supported in Mobile Agent environments:

- **Software-based MTPs in Cisco IOS gateways**—use these MTPs for Mobile Agent as they provide codec flexibility and better scalability compared with other MTP options. The following is a sample configuration on a gateway.

  ```
sccp local GigabitEthernet0/0
sccp ccm 10.10.10.31 identifier 1 priority 1 version 7.0
sccp ccm 10.10.10.131 identifier 2 priority 2 version 7.0
sccp
!
sccp ccm group 1
  associate ccm 1 priority 1
  associate ccm 2 priority 2
  associate profile 3 register gw84xcode
  associate profile 1 register gw84conf
  associate profile 2 register gw84mtp
!
dspfarm profile 3 transcode
  codec g729abr8
  codec g729ar8
  codec g711alaw
  codec g711ulaw
  codec g729r8
  codec g729br8
  maximum sessions 52
  associate application SCCP
!
dspfarm profile 1 conference
  codec g729br8
  codec g729r8
  codec g729abr8
  codec g729ar8
  codec g711alaw
  codec g711ulaw
  maximum sessions 24
  associate application SCCP
!
dspfarm profile 2 mtp
  codec g711ulaw
  maximum sessions software 500
  associate application SCCP
```

- **Hardware-based MTPs in Cisco IOS gateways**—These MTPs are supported. However, Cisco does not recommend them because of the extra cost, codec restrictions, and scalability constraints.

- **Software-based MTPs using the Cisco IP Voice Media Streaming Application**—These MTPs are not supported with Mobile Agents.

---

**Note**

Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to avoid using them. Create a new Media Resource Group (MRG) as a place holder, and place the software MTPs in that MRG. For instructions, refer to the Unified CM help documentation.

---

**Configure Media Termination Points in Unified CM**

**Add MTP Resources to Unified CM**

Perform these steps to add media termination points (MTPs) to Unified CM.
**Procedure**

**Step 1** In Unified CM Administration click Media Resources > Media Termination Point.

**Step 2** Click Add New.

**Step 3** Choose Cisco IOS Enhanced Software Media Termination Point from the Media Termination Point Type drop-down list.

**Step 4** Enter an MTP name. This name must match the device name you chose in IOS. In the example in the previous section, the MTP was called gw84mtp, as from the config line: associate profile 2 gw84mtp.

**Step 5** Choose the appropriate device pool.

**Step 6** Click Save and then click Apply config.

**Step 7** Navigate back to Media Termination Point and ensure the newly added MTP is listed as being registered with `<Unified CM subscriber IP address>` in the Status column.

**Step 8** Repeat steps 1 through 7 for each sccp ccm group you configured on each of your gateways.

---

**Configure Media Termination Point Resources in Unified CM**

This section explains how to create media resource groups and media resource group lists.

**Procedure**

**Step 1** Navigate to Media Resources > Media Resource Group in Unified CM Administration.

**Step 2** Click Add New.

**Step 3** Specify a name and description.

**Step 4** From the Available Media Resources that you just created, move the those devices from the Available to the Selected list by clicking the down arrow. Ensure that you do not include Unified CM Software resources. For example, type anything that starts with ANN_, MTP_, or MOH_.

**Step 5** Navigate to Media Resources > Media Resource Group List.

**Step 6** Click Add New.

**Step 7** Move the Media Resource Group you just created from the Available Media Resource Groups to the Selected Media Resource Groups.

**Step 8** Click Save.
**Associate Media Resource Group List with Device Pools**

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Navigate to System &gt; Device Pool and click on the device pool that contains the CTI ports for Mobile Agent. If there are multiple pools, perform the next step for each device pool that applies.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>In the Media Resource Group List drop-down list, select the Media Resource Group List that you just created, click Save and then click Apply config.</td>
</tr>
</tbody>
</table>

**Quarantine Unified CM Software-Based Resources**

Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to avoid using them. This, in effect, quarantines them.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Create a new Media Resource Group (MRG) as a placeholder.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Place the software MTPs in that MRG. For further instructions, refer to the Unified CM help documentation.</td>
</tr>
</tbody>
</table>

**Insert MTPs**

If you use SIP trunks, you must configure MTPs. This also applies if you use TDM trunks to interact with service providers. Mobile Agent cannot use an MTP with codec pass through. When you configure the MTP, you must select No pass through. KPML is not supported with Mobile Agent.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Log in to Unified CM Administration and select Device &gt; Trunk.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Select the trunk on which you want to configure MTPs.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Depending on the scenario listed below, perform the corresponding step listed in the Description column. Note that if you configure Trunk Groups to dynamically insert MTPs, only the calls that require MTPs use them.</td>
</tr>
</tbody>
</table>

- If you want to always insert MTPs for inbound and outbound calls through a given trunk: In the Trunk Configuration settings, select the Media Termination Point Required check box.

- If you want to dynamically insert MTPs when Unified ICM detects media or signaling incompatibility between the caller and called endpoints: In the Trunk Group Configuration settings, in DTMF Signaling Method, select RFC2833.
Enable Call Progress Tones for Agent-Initiated Calls

**Procedure**

When **MTP Required** is not enabled, extra configuration is required to enable an agent to hear call progress tones for agent initiated calls. If instead you have dynamic MTP allocation by forcing mismatched DTMF settings, then configure the Unified Communications Manager to enable Early Offer.

For information on configuring the Unified Communications Manager, see the **Unified Communications Manager product documentation**. The Cisco Annunciator does not generate ringback and other call progress tones, as it does for regular phones and softphones. Instead, Mobile Agent relies on the called party generating these tones (and the early offer setting triggers sending these tones to the agent).

**Note** This selection does not affect MTP sizing for IP Phones and other endpoints that support RFC2833 signaling, as is the case for many Cisco phones. For more information about supported phones, see the Cisco Compatibility Matrix Wiki.

Verify MTP Resource Utilization

Since Unified CM comes preconfigured with Software MTP resources, these resources may sometimes be used to provide MTP for Mobile Agent calls without proper configuration. Since we don't support the use of Unified CM based software MTP's, we explicitly quarantined them in the above section, Disabling Unified CM Based Software MTPs. To ensure that the new IOS-based MTP's are the ones being used for Mobile Agents, we recommend that you perform the following steps to verify that correct MTP's are used.

**Procedure**

**Step 1** Install the Unified CM Realtime monitoring tool. This tool can be downloaded under Application > Plugins within Unified CM Administration.

**Step 2** Place a call to a logged-in Mobile Agent.

**Step 3** Open the Unified CM Realtime monitoring tool and navigate to System > Performance > Open Performance Monitoring.

**Step 4** Expand the node(s) that are associated with your IOS-based MTP resources and choose Cisco MTP Device.

**Step 5** Double-click **Resources Active** and choose all of the available resources to monitor. This includes both IOS and Unified CM-based resources. Ensure that the only resources that are active during the Mobile Agent phone call are the IOS-based resources. Also, ensure that all UCM-based MTP resources are **not** active.

**Step 6** Repeat the previous step for each node that has MTP resources associated with it.

Enabled Connect Tone feature

In a nailed connection, the system can play a tone to the Unified Mobile Agent through the agent headset to let the agent know when a new call is connected. In the default Installation, the Mobile Agent Connect Tone feature is disabled.
Enable Mobile Agent Connect Tone

If you require Unified Mobile Agent Connect Tone, you must make the following change in the Windows Registry for the key PlayMAConnectTone under the JTAPI GW PG registry entries.

Perform the following procedure to allow a Mobile Agent in the nailed connection mode to hear a tone when a new call is connected.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>On the PG machine, open the Registry Editor (regedit.exe).</td>
</tr>
<tr>
<td>Step 2</td>
<td>Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\CiscoSystems, Inc\ICM\icm7\PG1A\PG\CurrentVersion\JGWS\jgw1\JGWData\Config\PlayMAConnectTone . The Edit DWORD Value dialog box appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Value data: field, enter 1 to enable Mobile Agent Connect Tone and click OK.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Exit the Registry Editor to save the change, and cycle the PG service.</td>
</tr>
</tbody>
</table>

Administration and Usage

CTI OS Agent Desktop

Unified Mobile Agent is available with the Cisco CTI OS Agent Desktop. CTI OS Agent Desktop provides an interface that:

• Enables you to perform telephony call control, such as call answer, hold, conference, and transfer, and agent state control, such as ready/not ready and wrap-up
• Presents customer call data in the form of a popup window
• Provides you with agent statistics and chat capability

Note

CTI OS supports chat only between agents on the same peripheral.

Note


Log in to CTI OS Agent Desktop

Perform the following steps to log in to the CTI OS Agent Desktop.
Procedure

**Step 1**  From the desktop, click **Login**.
The CTI Login dialog box appears.

*Figure 15: CTI Login*

**Step 2**  In the **CTI Login** dialog box, enter the following information in the corresponding fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to</td>
<td>Use the drop-down menu to select the connection mode you want to use.</td>
</tr>
</tbody>
</table>
| Agent ID or Agent Login Name | Your supervisor assigns your Agent ID.  
  **Note** You are prompted to enter either your Agent ID or Agent Login Name.  
  Login options are determined during the installation of the CTI OS Server. |
| Password             | Your supervisor assigns your this password.              |
| Instrument           | The directory number for the local CTI port; this is your Unified CCE phone extension. |
| Mobile Agent         | You must select this check box to log in as a Mobile Agent. |
| Phone Number         | The dial number for the phone the agent intends to use.  
  **Note** The format for the phone number must follow the dial plan, for example, 91201-123-xxxx. |
## Option and Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Mode</td>
<td>Use the drop-down menu to choose the connection mode you want to use: call</td>
</tr>
<tr>
<td></td>
<td>by call or nailed connection.</td>
</tr>
<tr>
<td>Note</td>
<td>Auto-answer is supported only with the nailed connection mode. Select</td>
</tr>
<tr>
<td></td>
<td>nailed connection.</td>
</tr>
</tbody>
</table>

### Step 3

Click **OK**.
The desktop automatically enters the state that is configured on the switch (either Ready or Not Ready) and the buttons for actions for that state are enabled.

**Note**
For a nailed connection, the desktop must receive and answer a setup call before agent login is complete.

---

### Related Topics

- [Connection modes](#), on page 45

---

### Verify login

Perform the following procedure to verify your login.

#### Procedure

**Step 1**
Check to be sure that your desktop is in the Ready or Not Ready state.

**Note**
Switch configuration determines the state the desktop enters at login time.

**Step 2**
Check to be sure the status bar of your Unified Mobile Agent Desktop displays the following:

- Agent ID for the logged-in agent
- Agent Extension
- Agent Instrument
- Current Agent Status
- The server that the desktop is connected to

**Step 3**
Check to be sure the action buttons that are allowed for your current agent state are enabled.

**Note**
If you log in as a Mobile Agent and want to make a phone call from CTI OS Agent Desktop, you must use the CTI Dialing Pad on the desktop.
Enable ringtone

Note
This procedure applies only to agents using CTI OS Agent Desktop in nailed connection delivery mode.

By default, a CTI OS Agent Desktop in nailed connection delivery mode does not ring when a call arrives. Instead, an alert message appears on the desktop to indicate the arrival of a call.

Perform the following procedure to enable a ringtone on the CTI OS Agent Desktop:

Procedure

Step 1
Click Dial.
The CTI Dialing Pad dialog box appears.

Step 2
Click More.
The Options dialog box appears.

Step 3
Click the Mute Tones tab and uncheck the Ring Back check box.
This action disables the Mute setting of the ringback tone.

Step 4
Click Close.

This setting remains in effect until you change it or log out. You need to repeat these steps each time you log in.

Related Topics
Nailed connections, on page 47

Enable Ready State

Note
Once you are placed in the Ready state, the ring tone is heard through the speakers of the physical machine where the Agent Desktop is installed.

Procedure
If you are in the Not Ready state and the Ready button is enabled, click the Ready button.
Initiate a Call

Procedure

**Step 1**  Enter a state from which you can make a call. (You are in the correct state to make a call if the Dial button is enabled.)

**Note**  Depending on the switch, you can also make calls if the Ready or Not Ready buttons are enabled.

**Step 2**  Use the CTI Dial Pad to enter a phone number.

Transfer a Call

Procedure

**Step 1**  Click the **Transfer** button.
The CTI Dialing Pad dialog box appears.

**Step 2**  Enter the phone number to be dialed in the Dialed Number field or select a destination from the pull-down menu.
The pull-down menu contains the last six numbers dialed from this desktop.

**Step 3**  Optionally, click the **More** button to display the Call Data tab, where you can optionally enter data associated with the call.

**Step 4**  Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you <em>do want to speak</em> with the consulted agent, click the <strong>Transfer Init</strong> button.</td>
<td>When you press the Transfer Init button, the call is put on hold. The agent has an opportunity to speak to the consulted agent before completing the transfer. When the consult call is answered, the button changes to <strong>Transfer Complete</strong>. To complete the transfer, click <strong>Transfer Complete</strong>.</td>
</tr>
<tr>
<td>If you <em>do not want to speak</em> with the consulted agent, click <strong>Single Step</strong>.</td>
<td>The call automatically transfers.</td>
</tr>
</tbody>
</table>

Conference a call

Procedure

**Step 1**  Click the **Conference** button.
The CTI Dialing Pad dialog box is appears.

**Step 2** Enter the phone number to be dialed in the Dialed Number field or select a destination from the pull-down menu. The pull-down menu contains the last six numbers dialed from this desktop.

**Step 3** Optionally, click the **More** button to display the CTI Dialing Pad.

**Step 4** Click the **Conference Init** button. This action places the call on hold, which gives you an opportunity to speak to the consulted agent before completing the conference. When you answer the consult call, the button changes to **Conference Complete**.

**Step 5** Click **Conference Complete** to complete the conference. The two calls now appear on the Call Information Grid as one call.

---

**Cisco Agent Desktop**

Unified Mobile Agent is available with the Cisco Agent Desktop.

Cisco Agent Desktop:

- Provides call control capabilities, such as call answer, hold, conference, and transfer, and ACD state control—ready/not ready, wrap up, and so on
- Presents customer information through an enterprise data window and an optional screen pop
- Requires minimum screen real estate and enables agents to customize its functionality to meet their individual needs

**Note** For more information about using Cisco Agent Desktop to handle calls, see *CTI OS Agent Desktop User Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*.

---

**Log in to Cisco Agent Desktop**

Perform the following procedure to start the Cisco Agent Desktop and log in as a Mobile Agent.

**Procedure**

**Step 1** Choose **Start > Programs > Cisco Desktop Agent**.
The Mobile Agent Login dialog box appears.

**Figure 16: Mobile Agent Login**

![Mobile Agent Login dialog box]

**Step 2** Enter your **Login Name/Agent ID**.
You are prompted to enter either your Agent ID or Login Name. Login options are determined during the installation of the CTI OS Server.

The maximum length for the Login Name field is 32 characters. For Agent ID, extension and password fields, the maximum data length is limited to 12 characters.

**Note**  If the login method (Login Name or Agent ID) is changed while you are in the process of logging in, an error message appears to indicate that the log in method has changed. You must restart agent desktop to log in using the new method.

**Step 3** Enter your **Password**.

**Step 4** Enter your **Extension**.
Agent desktop can control only those calls on the extension you enter in this field, regardless of whether the Mobile Agent is configured with multiple extensions.

**Step 5** Select **Mobile Agent Mode**.

**Step 6** Under Mobile Agent Parameters, select a call delivery mode.

**Step 7** Specify a **Mobile Agent Phone Number**. The dial number for the phone you are using.

**Note**  The Mobile Agent Phone Number field can contain only numeric characters.

**Step 8** Click **OK**.
The agent desktop starts and is immediately minimized on the taskbar at the bottom of the Mobile Agent's Windows desktop.
For a nailed connection, a setup call must be received and answered before agent login is complete.

Verify login to Cisco Agent Desktop

Procedure

Check to be sure your Cisco Agent Desktop displays the following:

- Your agent name, as configured in Unified ICM
- Your agent extension, as entered in the Login dialog box
- Your agent ID or name, as entered in the Login dialog box
- Your current agent state and the time spent in that state
- Current status of agent desktop features
- Current system time

Note Remember, you must enter the Ready state before you can begin processing calls.

Enable Ready state

You must be set to the Ready state to answer an ACD call.

Procedure

On the toolbar, click Ready.

Initiate a call

Procedure

Step 1 Click Not Ready.  
Note You must be in the Not Ready state to initiate a call.

Step 2 Click Make Call.  
The Make a Call window appears.

Step 3 Enter a number in the Name: Number field.

Step 4 Click Dial.
Transfer a call

There are two types of transfer calls:

- **Supervised transfers**: In a supervised transfer, the Mobile Agent speaks to the third party to whom the call is being transferred before connecting the active call; this allows the Mobile Agent to confirm that the third party is ready to accept the call.

- **Blind transfers**: In a blind transfer, the Mobile Agent transfers the active call to the third party without speaking. The remote agent hangs up before the third party answers the phone and therefore, cannot confirm if the third party is ready to accept the call.

Use the following instructions to transfer a call.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>With a call active, click <strong>Transfer</strong>. The <strong>Transferring Call</strong> window appears.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Enter the phone number to which the remote agent is transferring the call in the Name: Number field.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click <strong>Dial</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>When the phone rings, the <strong>Dial</strong> button changes to the <strong>Transfer</strong> button.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Do one of the following:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you want to do a supervised transfer</td>
<td>Wait for the third person to answer the phone, announce the transfer, then click <strong>Transfer</strong>.</td>
</tr>
<tr>
<td>If you want to do a blind transfer</td>
<td>Click <strong>Transfer</strong> without waiting for the third person to pick up the phone.</td>
</tr>
</tbody>
</table>

Conference a Call

There are two types of conference calls:

- **Supervised conference**: In a supervised conference, the Mobile Agent speaks to the third party the agent wants to add to the call before completing the conference, to confirm that the third party is ready to accept the call.

- **Blind conference**: In a blind conference, the Mobile Agent adds the third party to the conference without speaking to them.
When using a blind conference to add someone to the call, the remote agent might or might not see the call tagged as a conference call in the dashboard pane.

Use the following instructions to make a conference call.

**Procedure**

**Step 1**
With a call active, click Conference. The Conference window appears.

**Step 2**
Enter the phone number of the person the Mobile Agent wants to add to the call in the Name: Number field.

**Step 3**
Click Dial. When the phone rings, the Dial button changes to the Add to Conf button.

**Step 4**
Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you want a supervised conference</td>
<td>Wait for the third person to answer the phone, announce the conference, then click Add to Conf.</td>
</tr>
<tr>
<td>If you want a blind conference</td>
<td>Click Add to Conf without waiting for the third person to pick up the phone.</td>
</tr>
</tbody>
</table>

The Conference window closes.

**Step 5**
To add one or more people to the conference call, repeat Steps 1 to 4 for each person.

**Note**
The total number of conference call participants on a call is determined by settings on the Unified CM. Ask you supervisor for the total number configured for your contact center.

**Cisco Finesse**

Finesse provides a browser-based desktop for agents and supervisors. Mobile agents can perform the same call control functions as Packaged CCE agents. Mobile supervisors can perform all call control functions except for silent monitoring.
Sign in to Cisco Finesse Agent Desktop

Procedure

**Step 1** Enter the following URL in your browser: http://hostname/, where hostname is the hostname or IP address of the Finesses server.

**Step 2** In the ID field, enter your agent ID.

**Step 3** In the Password field, enter your password.

**Step 4** In the Extension field, enter your extension.
For a mobile agent, the extension represents the virtual extension for the agent, also known as the local CTI port (LCP).

**Step 5** Check the **Sign in as a Mobile Agent** check box. The Mode and Dial Number fields appear.

**Step 6** From the Mode drop-down list, choose the mode you want to use.
In **Call by Call** mode, your phone is dialed for each incoming call and disconnected when the call ends.
In Nailed Connection mode, your phone is called when you sign in and the line stays connected through multiple customer calls.

**Step 7** In the Dial Number field, enter the number for the phone you are using.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The agent ID.</td>
</tr>
<tr>
<td>Password</td>
<td>Your supervisor assigns your this password.</td>
</tr>
<tr>
<td>Extension</td>
<td>The agent's extension.</td>
</tr>
<tr>
<td>Sign in as Unified Mobile Agent</td>
<td>Select to sign in as a Unified Mobile Agent.</td>
</tr>
<tr>
<td>Mode</td>
<td>Nailed Connection is the only available selection.</td>
</tr>
</tbody>
</table>
Thenumberofthephonebeingused.

**Option**  | **Description**  
--- | ---  
Dial Number  | The number of the phone being used.  

**Step 8**  
Click **Sign In**.

**Note**  
In Nailed Connection mode, the desktop must receive and answer a setup call before sign-in is complete.

In Call by Call mode, the dial number provided is not verified. To ensure the number is correct, verify the number in the header on the Agent Desktop after sign-in is complete.

---

**Verify sign-in to Cisco Finesse**

**Procedure**

Check to be sure the Finesse Agent Desktop displays the following in the header:

- *Mobile Agent* before your agent name
- The mode used (Call by Call or Nailed Connection)
- The dial number you provided

---

**Enable Ready state**

You must be in Ready state to process incoming calls.

**Procedure**

Choose **Ready** from the drop-down list below the agent name.

**Note**

If you are in Call by Call mode, you must answer each incoming call on your physical phone. After you answer a call, you can perform all other call control functions (such as Conference, Transfer, Hold, Retrieve) using the desktop.

If you are in Nailed Connection mode, after you answer the initial setup call, you must perform all other call control functions using the desktop.
Make a call

Procedure

Step 1  From the drop-down list below the agent name, choose Not Ready.
   Note  You must be in Not Ready state to make a call.

Step 2  Click Make a New Call.

Step 3  Enter the number you want to call on the keypad, and then click Call.
    If you are in Call by Call mode, the CTI server sends a setup call to your phone. A message appears on the keypad that states the following:

A call will be initiated to your phone which must be answered before an outbound call to your destination can be made.

After the setup call is answered, the system establishes the outbound call to the destination specified.
Precision Routing

- Capabilities, page 87
- Initial setup, page 91

Capabilities

Precision Queues

Precision routing offers a multidimensional alternative to skill group routing: using Unified CCE scripting, you can dynamically map the precision queues to direct a call to the agent who best matches the caller’s precise needs. Precision queues are the key components of precision routing.

To configure Precision Routing, you must do the following:

1. Create attributes. Attributes are characteristics that can be assigned a True | False value or a Proficiency rating from 1 to 10.
2. Assign attributes to agents.
3. Create precision queues.
4. Create routing scripts.

There is no need to add an agent to a precision queue; agents become members of precision queues automatically based on their attributes. If a precision queue requires an agent who lives in Boston, who speaks fluent Spanish, and who is proficient in troubleshooting a specific piece of equipment, an agent with the attributes Boston = True, Spanish = True, and Repair = 10 is automatically part of the precision queue. A Spanish caller in Boston who needs help with equipment is routed to that agent.

A precision queue includes:

- Terms--A term compares an attribute against a value. For example, you can create the following term: Spanish == 10. The term of the attribute is the highest proficiency in Spanish.

Each precision queue can have multiple attributes, and these attributes can be used in multiple terms. For example, to select an agent with a Spanish proficiency value between 5 and 10, you would create one term for Spanish > 5 and another for Spanish < 10.
Skill Groups or Precision Queues?

Should you use skill groups or precision queues for the routing needs of your organization? This section distinguishes the two methods.

**Use a Skill Group**

A skill group represents a competency or responsibility. For example, it could be a predefined collection of traits, such as salespeople who are in charge of selling to England. The skill group could be called "English sales". If you wanted to divide the agents in this group into two types of proficiencies (perhaps based on experience), you would need to set up two separate skill groups; for example, English Sales 1 and English Sales 2. You would then associate an agent with one of them, based on the agent's proficiency. Do this by accessing the skill group and locating the agent that you want to add to it (or add that skill group to the agent). To summarize, creating a skill group involves first building a concept of what combinations of traits you want for each agent, like English Sales 2.

**Use a Precision Queue**

In contrast to skill groups, a precision queue breaks down attribute definitions to form a collection of agents at an attribute level. The agents that match the attribute level of the precision queue become associated with that precision queue.
With precision queues, the preceding English sales example involves defining the attributes English and Sales, and associating agents that have those traits to them. The precision queue English Sales would dynamically map all those agents that had those traits to the precision queue. In addition, you can define more complex proficiency attributes to associate with those agents. This would allow you to build, in a single precision queue, multiple proficiency searches like English language proficiency 10 and sales proficiency 5.

To break down the precision queue example into skill groups, you would need to set up two separate skill groups: English language proficiency 10 and sales proficiency 5. With precision queues, you can refine agents by attributes. With skill groups, you define a skill group and then assign agents to it.

**Decide on Skill Groups or a Precision Queue**

Precision routing enhances and can replace traditional routing. Traditional routing looks at all of the skill groups to which an agent belongs and defines the hierarchy of skills to map business needs. However, traditional routing is restricted by its single-dimensional nature.

Precision routing provides multidimensional routing with simple configuration, scripting, and reporting. Agents are represented through multiple attributes with proficiencies so that the capabilities of each agent are accurately exposed, bringing more value to the business.

If your routing needs are not too complex, consider using one or two skill groups. However, if you want to conduct a search involving as many as ten different proficiency levels in one easily managed queue, use precision queues.

**Attributes**

Attributes identify a call routing requirement, such as language, location, or agent expertise. You can create two types of attributes: Boolean or Proficiency.

- Use Boolean attributes to identify an agent attribute value as true or false. For example, you can create a Boston attribute that specifies that the agent assigned to this attribute must be located in Boston. An agent in Boston would have *Boston = True* as the term for that attribute.

- Use Proficiency attributes to establish a level of expertise in a range from 1 to 10, with 10 being the highest level of expertise. For a Spanish language attribute, for example, a native speaker would have the attribute *Proficiency = 10*.

When you create a precision queue, you identify which attributes are part of that queue and then implement the queue in a script. When you assign a new attribute to an agent and the attribute value matches the precision queue criteria, the agent is automatically associated with the precision queue.

**Precision Queue Call Flow Example**

At a high level, consider a 5-step precision queue with a Consider If formula for *Caller is Premium Member* attached to the Step 1:

- Step 1 - Attribute: Skill > 8 - Consider If: Caller is Premium Member
- Step 2 - Attribute: Skill > 6
- Step 3 - Attribute: Skill > 4
- Step 4 - Attribute: Skill > 3
• Step 5 - Attribute: Skill >= 1

Caller John, who is not a premium customer, calls 1-800-repairs. John's call is routed to this precision queue.

• Since John is not a premium customer, he is immediately routed out of Step 1 (because of the Consider If on Step 1) and into Step 2 where he waits for his call to be answered.

• After the Step 2 wait time has expired, John's call moves to Step 3 to wait for an agent.

• After the Step 3 wait time has expired, John's call moves to Step 4 to wait for an agent.

• When it arrives at Step 5, John's call will wait indefinitely for an available agent. This step cannot be avoided by any call because there is no routing logic past this.

The overarching idea is that customer will use each successive step to expand the pool of available agents. Eventually, when you reach the "last" step (the step with the highest number), the call is waiting in a potentially very large pool of agents. With each extra step, the chances of the call being handled increase. This also puts the most valuable and skilled agents in the earlier precision queue steps. Calls come to them first before moving on the less appropriate agents in later steps.

Scripts for Precision Queues

To implement Precision Routing in your contact center, you must create scripts.

You can create and use configured (static) and dynamic precision queue nodes in your scripts.

• Static precision queue nodes target a single, configured precision queue. When the script utilizes a single precision queue, use static precision queues.

• Dynamic precision queue nodes are used to target one or more previously configured precision queues. Use dynamic precision queues when you want a single routing script for multiple precision queues (for example, when the overall call treatment does not vary from one precision queue to another). Dynamic precision queues can simplify and reduce the overall number of routing scripts in the system.

Precision Queue Script Node

Use the Precision Queue script node to queue a call based on caller requirements until an agent with desired proficiency become available. This node contains multiple agent selection criteria which are separated into steps.

A single call can be queued on multiple precision queues. If an agent becomes available in one of the precision queues, the call is routed to that resource. You cannot reference multiple precision queues with a single Precision Queue node. However, you can execute multiple Precision Queue nodes sequentially to achieve this.

The Precision Queue node includes a Priority field, which sets the initial queuing priority for the calls processed through this node versus other calls queued to the other targets using different nodes. The priority is expressed as an integer from 1 (top priority) to 10 (least priority). The default value is 5.

If more than one call is queued to a precision queue when an agent becomes available, the queued call with the lowest priority number is routed to the target first. For example, assume an agent in a precision queue becomes available and two calls are queued to that precision queue. If one call has priority 3 and the other has priority 5, the call with priority 3, the lower value, is routed to the precision queue while the other call continues to wait. If the priorities of the two calls are same, then the call queued first is routed first.
VRU (voice response unit) script instructions are not sent to the VRU. If a call enters the precision queue node and no resource is available, the call is queued to the precision queue and the node transfers the call to the default VRU, if the call is not already on a VRU. The script flow then exits immediately through the success branch. The script should then continue with a run external script node to instruct the VRU what to do while holding the call until an agent becomes available. Typically, this invokes a network VRU script that plays music-on-hold, possibly interrupted on a regular basis with an announcement. The script flow can also use other queuing nodes to queue the same call to other targets, for example, Queue to Skill Group and Queue to Agent.

**Queuing Behavior of the Precision Queue Node**

Precision queues internally are configured with one or more time-based steps, each with a configured wait time. After a call is queued, the first step begins and the timer starts. This occurs although the execution path of the script exited the success node and a new node may be targeted (for example, Run Ext. Script).

If the timer for the first step expires, control moves to the second step (assuming one exists), and so on. As long as the call remains in queue and there are steps left to execute, the call internally continues to move between steps regardless of the path the call takes after it leaves the precision queue node. If a call is queued to two or more precision queues, the call internally walks through the steps for each precision queue in parallel. After the call reaches the last step on a precision queue, it remains queued on that step until the call is routed, abandoned, or ended.

**Initial setup**

**Add Attributes**

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Navigate to <strong>Unified CCE Administration Manage &gt; Agent &gt; Attributes.</strong></td>
</tr>
<tr>
<td>Step 2</td>
<td>In the <strong>List of Attributes</strong> window, click <strong>New.</strong></td>
</tr>
<tr>
<td>Step 3</td>
<td>Complete the following fields.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>yes (for departmental administrators)</td>
<td>A departmental administrator must select one department from the departments popup list to associate with this attribute. The list shows all of this administrator's departments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A global administrator can leave this field set to the default, which sets the attribute as global (belonging to no departments). A global administrator can also select a department for this attribute.</td>
</tr>
</tbody>
</table>
**Field** | **Required?** | **Description**
---|---|---
Name | yes | Type a unique attribute name. For example, to create an attribute for mortgage insurance, type "mortgage".
Description | yes | Enter a maximum of 255 characters to describe the Dialed Number String.
Type | yes | Select the type: Boolean or Proficiency.
Default | yes | Select the default (True or False for Boolean, or a number from 1 to 10 for Proficiency).

**Step 4** Click **Save**.

---

**Search for Agents**

The Search field in the Agents tool offers an advanced and flexible search. Click the + icon at the far right of the Search field to open a popup window, where you can:

- Select to search for agents only, supervisors only, or both.
- Enter a username, agent ID, first or last name, or description to search for that string.
- Enter one or more team names separated by spaces. (Team is an OR search—the agent or supervisor must be a member of one of the teams.)
- Enter one or more attribute names separated by spaces. (Attributes is an AND search—the agent or supervisor must have all attributes.)
- Enter one or more skill group names separated by spaces. (Skill Groups is an AND search.)
- Select departments, with options for **Globals and Departments**, **Globals only**, or **Departments only**. Selecting **Globals and Departments** or **Departments only** enables an input field where you can enter a space-separated list of department names. (Departments is an OR search.)

**Note** Search by department is enabled only when departments are configured.
Assign Attributes to Agents

Procedure

Step 1 With the selected agent displayed, click the Attributes tab.
Step 2 Complete the Attributes tab:
This tab shows the attributes associated with this agent and their current values. If the agent has no attributes, the Name field shows "No Items Found" and "No Items".
Click Add to open a popup list of all attributes, showing the name and current default value for each.
  a) Click the attributes you want to add for this agent.
  b) Set the attribute value as appropriate for this agent.
  c) Click Save to return to the List window, where a message confirms the successful creation of the agent.
To enter or change fields in the other tabs, click those tabs.

Add precision queue

Procedure

Step 1 Navigate to Unified CCE Administration Manage > Agent > Precision Queues.
This opens a List of Precision Queues window showing all precision queues that are currently configured.
Step 2 Click New to open the New Precision Queue window. Complete the fields.
A departmental administrator must select one department from the department popup list to associate with this precision queue. The list shows all of this administrator's departments.

A global administrator can leave this field set to the default, which establishes the precision queue as global (belonging to no departments). A global administrator can also select a department for this precision queue.

When an administrator selects a department for the precision queue, the popup lists for attributes and bucket intervals show global objects and objects in that department.

When an administrator changes the precision queue department, selections for bucket intervals and attributes are cleared if the selections do not belong to the new department or the global department.

<table>
<thead>
<tr>
<th>Name</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>yes (for department administrators only)</td>
<td>A departmental administrator must select one department from the department popup list to associate with this precision queue. The list shows all of this administrator's departments. A global administrator can leave this field set to the default, which establishes the precision queue as global (belonging to no departments). A global administrator can also select a department for this precision queue. When an administrator selects a department for the precision queue, the popup lists for attributes and bucket intervals show global objects and objects in that department. When an administrator changes the precision queue department, selections for bucket intervals and attributes are cleared if the selections do not belong to the new department or the global department.</td>
</tr>
<tr>
<td>Description</td>
<td>no</td>
<td>Enter up to 255 characters to describe the precision queue.</td>
</tr>
</tbody>
</table>
Service Level Type | yes | Select the service level type used for reporting on your service level agreement.

Service level type indicates how calls that are abandoned before the service level threshold affect the service level calculation. This is a drop-down menu that defaults to Ignore Abandoned Calls, and includes these options:

- **Ignore Abandoned Calls:** Select this option if you want to exclude abandoned calls from the service level calculation.

- **Abandoned Calls have Negative Impact:** Select this option if you want only those calls that are answered within the service level threshold time to be counted as treated calls. The service level is negatively affected by calls that abandon within the service level threshold time.

- **Abandoned Calls have Positive Impact:** Select this option if you consider a call that is abandoned within the service level threshold time as a treated call. With this configuration, abandoned calls have a positive impact on the service level.

Service Level Threshold | yes | Enter the time in seconds that calls are to be answered based on your service level agreement.

The time that you enter in this field is used to report on service level agreements and does not affect how long a call remains in a precision queue. The length of time a call remains in a step is determined by the wait time for each individual step.
<table>
<thead>
<tr>
<th>Name</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
</table>
| Agent Order        | yes       | Select an option to determine which agents receive calls from this queue. The ordering of agents does not dictate the agents who are selected into a Precision Queue step. Agents are included or excluded based on the conditions specified for the step.  
|                    |           | • **Longest Available Agent** (default): The default method of agent ordering for a precision queue. The call is delivered to the agent who has been in the available (or ready) state the longest.  
|                    |           | • **Most Skilled Agent**: The call is delivered to the agent who has the highest competency sum from all the attributes pertinent to the Precision Queue step. In an agent-rich environment, this can mean that more competent agents would be utilized more than less competent agents.  
|                    |           | • **Least Skilled Agent**: The call is delivered to the agent who has the lowest competency sum from all the attributes pertinent to the Precision Queue step. |
| Bucket Intervals   | no        | Select the bucket interval whose bounds are to be used to measure the time slot in which calls are answered. To select a different bucket interval:  
|                    |           | 1 Click the magnifying glass icon to display **Select Bucket Intervals**.  
|                    |           | 2 Click a link to make a selection and close the list. |
Step 3  Click the numbered Step Builder link (Step 1, Step 2, and so on) to open the Step Builder popup window.

Step 4  When you have finished adding, click Save.

Consider If Formula for Precision Queue

If you are not on the last step of the precision queue, then you can enter a Consider If formula for that step. A Consider If formula evaluates a call (within a step) against additional criteria. Each time a call reaches a step with a Consider If expression, the expression is evaluated. If the value for the expression returns as true, the call is considered for the step. If the value returns as false, the call moves to the next step. If no expression is provided for a step, the step is always considered for calls.

To add a Consider If formula, type the formula into the Consider If box. Alternatively, you can use the Script Editor to build the formula and then copy and paste it into the Consider If box. Objects used in Consider If formulas are case-sensitive. All Consider If formulas that you add to a precision queue must be valid. If you add an invalid formula, you cannot save the precision queue. To ensure that the formula is valid, use Script Editor to build and validate the formula.

Only the following scripting objects are valid in a Consider If formula:

- Call
- PQ
- Skillgroup
- ECC
- PQ Step
- Call Type
- Custom Functions (You can create custom functions in Script Editor.)

It is possible that a valid Consider If formula can become invalid. For example, if you delete an object used in the formula after you create or update the precision queue, the formula is no longer valid.

Consider If Formula Examples

- PQ1.LoggedOn > 1--Evaluates whether there is more than one agent logged in to this queue.
- CallType.CallType1.CallsRoutedToday > 100--Evaluates whether more than 100 calls of this call type were routed today.
- PQStep.PQ1.1.RouterAgentsLoggedIn > 1--Evaluates whether there is more than one router agent logged in to this queue for Step 1.
- CustomFunction(Call.PeripheralVariable1) > 10--Evaluates whether this formula using a custom function returns a value greater than 10.
Build Precision Queue Steps

Every precision queue must have a step, and every step must have an Expression. An Expression is a collection of attribute terms.

Procedure

Step 1  Enter all required fields for the new precision queue.

Step 2  Click the numbered step link in the Steps panel (Step 1, Step 2, and so on).
This opens a step number window.

Step 3  Build the first step as follows.

a) Bypass the Consider if and Wait for fields. They are display-only on the first and last step of a precision queue. As soon as you create a second step, you can return to the first step and enter values for Consider if and Wait for.

b) Click the magnifying glass icon to the right of the Select Attribute field in the Expression 1 panel.

c) Select an attribute from the list.

d) Use the two Select fields to establish the terms of the attribute. Click the first Select field to choose an operator.

   • For Boolean attributes, choices are the operators for Equal and Not Equal.

   • For Proficiency attributes, choices are the operators for True, False, Less Than, Less Than or Equal To, Greater Than, and Greater Than or Equal To.

e) Click the second Select field to choose a value.

   • For Boolean attributes, values are True and False.
• For Proficiency attributes, values are numbers from 1 to 10.

Your selection creates an attribute term for the Expression. At this point, the term will appear in the precision queue similar to this: [(Spanish == 10)]. The term is a requirement that the agent must be fluent in Spanish.

**Step 4**  
To add a second attribute to the first Expression, click **Add Attribute** in the **Expression 1** row.

a) Select **AND** or **OR** to establish the relationship between the first and second attributes.

b) Repeat steps 3b, 3c, and 3d.

**Step 5**  
Continue to add attributes to **Expression 1**.  
All attributes within an expression must be joined by the same logical operator. They must all be ANDs, or they must all be ORs.

**Step 6**  
To add a second **Expression**, click the **Add Attribute** drop-down in the **Expression 1** row and select **Add Expression**.

**Step 7**  
Select **AND** or **OR** to establish the relationship between the first and second Expressions.

**Step 8**  
Add attributes to **Expression 2**.

**Step 9**  
Continue to add Expressions as needed.
In this example, a Spanish caller located in the Boston area needs an onsite visit from a technician to repair his ServerXYZ. An ideal agent should be fluent in Spanish and have the highest proficiency in ServerXYZ. This can be seen in Expression 1. Expression 2 allows us to specify that the selected agent must also be from either Boston or the New England area.

**Step 10**  When you have completed the step, click **OK** to add it to the precision queue.

**Step 11**  To build the next step, click the numbered step link in the Steps panel (Step 1). Each successive step is prepopulated with the Expressions and attributes of its predecessor. Decrease the attribute qualifications and competencies in successive steps to lower the bar such that the pool of acceptable agents increases.

**Step 12**  When you have created all steps, you can open any step except the last and enter values in the **Consider if** and **Wait for** fields.

- **Consider if** is a formula that evaluates a call within a step against additional criteria.
- **Wait for** is a value in seconds to wait for an available agent. A call will queue at a particular step and wait for an available agent matching that step criteria until the number of seconds specified. A blank wait time indicates that the call will proceed immediately to the next step if no available agents match the step criteria. Wait time defaults to 0 and can take a value up to 2,147,483,647.
Configure a Static Precision Queue

Procedure

Step 1 In the Precision Queue Properties dialog box, select the Statically option.
Step 2 From the list, select a precision queue to which to route all calls that enter this node.
Step 3 In the Priority selection box, select the initial queuing priority for calls processed through this node. You can select from 1 - 10. The default is 5.
Step 4 Check the Enable target requery check box to enable the requery feature for calls processed through this node. The requery behavior for the Precision Queue node is to be determined.
Step 5 To edit a precision queue, select a precision queue from the list, and then click Edit Precision Queue.

Configure a Dynamic Precision Queue

Procedure

Step 1 In the Precision Queue Properties dialog box, select the Dynamically option.
Step 2 In the Priority selection section, select the initial queuing priority for calls processed through this node. You can select from 1 - 10. The default is 5.
Step 3 Check the Enable target requery check box to enable the requery feature for calls processed through this node. The requery behavior for the precision queue node is to be determined.
Step 4 Select a queue option:
   • To dynamically route calls that enter this node to a precision queue name, select the Precision Queue Name option.
   • To dynamically route calls that enter this node to a precision queue ID, select the Precision Queue ID option.
Step 5 Click Formula Editor to create a formula that determines the precision queue name or ID to which to route calls.
Configure a Dynamic Precision Queue
Whisper Announcement

- Whisper Announcement Capabilities, page 103
- Deployment Tasks, page 104

Whisper Announcement Capabilities

Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent to handle the call. The information can include caller language preference, choices the caller made from a menu (Sales, Service), customer status (Platinum, Gold, Regular), and so on.

After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts. The determination of which announcement to play is controlled in the script and is based on various inputs, such as the dialed number, a customer ID look up in your customer database, or selections you made from a VRU menu.

Whisper Announcement Functional Limitations

Whisper Announcement is subject to these limitations:

- Announcements do not play for outbound calls made by an agent. The announcement plays for inbound calls only.
- For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU or TranslationRouteToVRU node before you send the call to the agent. You must send the transferred call to Unified CVP before you send the call to another agent. Then, Unified CVP can control the call and play the announcement, regardless of which node sends the call to Unified CVP.
- Announcements do not play when the router selects the agent through a label node.
- CVP Refer Transfers do not support Whisper Announcement.
- Whisper Announcement supports Silent Monitoring (CTI OS and Unified CM-based) with this exception: For Unified Communications Manager-based Silent Monitoring, supervisors cannot hear the
announcements themselves. The supervisor desktop dims the Silent Monitor button while an announcement plays.

- Only one announcement can play for each call. While an announcement plays, you cannot put the call on hold, transfer, or conference; release the call; or request supervisor assistance. These features become available again after the announcement completes.

Deployment Tasks

The following list shows the high-level tasks that are required to deploy Whisper Announcement. Individual steps are covered in more detail in later sections.

1. Ensure your deployment meets the baseline requirements for software, hardware, and configuration described in the System Requirements and Limitations section. See the Unified Contact Center Design Guide.

2. Create Whisper Announcement Audio Files, on page 104.

3. Deploy Whisper Announcement Audio Files to Media Server, on page 105.


5. Add Whisper Announcement to Routing Scripts, on page 107.


Example scripts that enable Whisper Announcement are installed with your system. For information about these scripts and how to access them, see Whisper Announcement Sample Scripts, on page 110.

Create Whisper Announcement Audio Files

You must create audio files for each different Whisper Announcement you want to use on your system; for example, “Sales, English” or “Soporte Técnico en Español.” Create the files using the recording tool of your choice.

When recording your files, follow these rules:

- The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and format requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).
- To avoid cutting off files when they are played, make sure they do not exceed the Whisper Announcement play limit (15 seconds).
- Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.
- To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is easy for you and others to remember. For example, en_sales.wav, sp_support.wav.
Deploy Whisper Announcement Audio Files to Media Server

Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you prefer. The most important consideration is where on the server to place the files. HTTP requests for media server audio files are constructed as:

\[
\text{http://<media_server>/<locale_directory>/<application_directory>/<file_name>}
\]

The CVP defaults for the locale and application directories are \text{en-us/app}. Unified CCE automatically adds \text{en-us/app} to the server name when making HTTP requests for media files.

For example, if:

- The script node that defines the media server has a value of \text{http://myserver.mydomain.com}
- The script node that defines the audio file to play has a value of \text{en_sales.wav}

Then the HTTP request for the file is automatically constructed as:

\[
\text{http://myserver.mydomain.com/en-us/app/en_sales.wav}
\]

If you store your files in a different locale and application directory, your routing scripts must include variable nodes that define those alternate locations. Make note of the directories in which you place your files and communicate the locations to your script authors.

Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read access.

**CVP with the Streaming Audio (Helix) and Whisper Announcement**

You must set the \text{user.microapp.media_server} variable, to point to the whisper announcement .wav file, for the CVP Whisper Announcement feature to work while Streaming Audio feature (using Helix) is also on. This is achieved by setting the \text{Call.WhisperAnnouncement} variable to the complete URL of the whisper announcement wav file. The \text{Call.WhisperAnnouncement} variable should be put in using the \text{http://<mediaserverio>:80/en-us/app/XXX.wav} URL format.

**Using a Default Media Server**

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see your CVP documentation for more information.) If a default media server is defined in CVP, script authors need not identify the media server in their call routing scripts provided the files that they request are available from that server.

**Configure Whisper Service Dialed Numbers**

For Whisper Announcement, Unified CVP uses two different dialed numbers when transferring a call to an agent:

- The first number calls the ringtone service that the caller hears while the whisper plays to the agent. The CVP default for this number is 91919191.
- The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.
Whisper Announcement dialed number is always an extension of the Ringtone dialed number with an extra two zeros at the end.

For Whisper Announcement to work, your dial plan must include both of these numbers. The easiest way to ensure coverage is through the use of wild cards such as 9191*.

Configure Dialed Numbers

You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable Local Static Route. Once Enable Local Static Route is checked, select either Route to Device or Route to SIP Server Group for VXML gateways. Then save and deploy the dialed number.

It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts with the overall dial number plan.

Change the Whisper Announcement Default Dialed Number

To override the DN pattern from the SIP subsystem level in CVP OAMP:

Procedure

2. Select the Call Server on which to override the default whisper DN.
3. Select the SIP tab.
4. Override the default value of 91919191 configured under the DN on the Gateway to play the ringtone field.
5. Click Save & Deploy.

Configure Ringtone Dialed Number

To configure the Ringtone dialed number in the CVP Operations Console:

2. Select the Call Server on which you want to configure the settings.
3. Select the SIP tab.
4. In the DN on the Gateway to play the ringtone field, configure the default Ringtone dialed number Pattern.

Dialed Number in the Dial-Peer

In addition to configuring the dial plan in Unified CVP, examine your IOS dial-peer. Make sure that the dialed number setting in your dial-peer configuration accommodates both of the whisper service dialed numbers.
Add Whisper Announcement to Routing Scripts

To enable Whisper Announcements, use the Script Editor to modify your routing scripts as follows:

- Specify the WhisperAnnouncement call variable
- Specify the Unified CVP media server and location of whisper audio files
- Specify other required variables

For more information, see Whisper Announcement Sample Scripts, on page 110.

Specify Whisper Announcement Call Variable

To include Whisper Announcement in a script, insert a Set Variable node that references the WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a result, you use only one WhisperAnnouncement set node for each script. However, as needed, you can set the variable at multiple places in your scripts to allow different announcements to play for different endpoints. For example, for skills-based routing, you can specify the variable at each decision point used to select a particular skill group or Precision Queue.

Note

Only one Whisper Announcement can play for each call. If a script references and sets the WhisperAnnouncement variable more than once in a single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Whisper Announcement:

- Object Type: Call.
- Variable: Must use the WhisperAnnouncement variable.
- Value: Specify the filename of the whisper file. For example: “my_whisper.wav” or “my_whisper”.
  - Specify the filename only, not its path.
  - You must enclose the filename in quotation marks.
  - The filename is not case sensitive.
  - The filename cannot include spaces or characters that require URL encoding.
  - The .wav extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP request.

Specify Unified CVP Media Server Information

If you define a default media server in your CVP Operations Console and it is the server from which you serve your whisper files, then you need not specify the media server in your routing scripts. However, if you do not define a default media server, or if you store your whisper file on a server other than the default, then your scripts must include a Set Variable node that identifies that server.
To specify your media server, use the following settings in the Set Variable node:

- Object Type: Call.
- Variable: Must use the user.microapp.media_server ECC variable.
- Value: Specify the HTTP path to the server. For example: "http://myserver.mydomain.net." You must enclose the path in quotes.
- Alternately you can specify an IP address in place of a DNS. Include the listening port number if the media server web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).

**Specify Whisper File Locale and Application Directories**

CVP uses a default storage directory for media files: <web_server_root>/en-us/app. To take advantage of this, Unified CCE call routing scripts automatically add "en-us/app," to the server name when constructing HTTP requests for media files. For example:

- If the script node that defines the media server has a value of "http://myserver.mydomain.com" and...
- The script node that defines which audio file to play has a value of "en_sales.wav," then...
- The HTTP request for the file is automatically constructed as


If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your script that identifies the locale directory. Similarly, if your whisper files are stored in a different application directory, you must add a Set Variable node that identifies that directory.

**Specify Locale Directory**

Use these settings in the Set Variable node to specify your locale directory:

- Object Type: Call.
- Variable: Must use the user.microapp.locale ECC variable.
- Value: Specify the directory name. For example: "pt-br," You must enclose the path in quotes.

**Specify Application Directory**

Use these settings in the Set Variable node to specify your application directory:

- Object Type: Call.
- Variable: Must use the user.microapp.app_media_lib ECC variable.
- Value: Specify the directory name. For example: to use a directory "wav_files" in place of the default directory "app," enter "wav_files." To use a sub-directory "wav_files" "app," enter "app/wav_files." You must enclose the path in quotes.

**Variable Length for Media Server Locale and Application Directory Variables**

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of "http://mysubdomain.mydomain.co.uk," the string is 33 characters long. Therefore, the Maximum Length setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase
the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools > Expanded Call Variables List.

Test Whisper Announcement File Path

To test the path to the whisper file that you defined in your script variables, enter the complete URL into a browser. The .wav file should play. For example:

- If your script includes: default media server + default locale + default application directory + whisper.wav, then the path is “http://<default_media_server>/en-us/app/whisper.wav”
- If your script includes: http://my_server.my_domain.com + default locale + “app/wav_files” + whisper.wav, then the path is “http://my_server.my_domain.com/en-us/app/wav_files/whisper.wav”

Other Script Settings That Are Required for Whisper Announcement

These additional settings are required for Whisper Announcement to work:

- Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target an agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and Select. If Target Requery is not enabled, the Whisper Announcement does not play.
- When you run an agent transfer or a conference script, use a SendToVRU, a TranslationToVRU, or a Run Script Request node before you target an agent.

Fail-Safe Timeout for Whisper Announcement in Unified CCE

Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second message when the announcement ends. The time stamps from these messages are used to calculate Whisper Announcement data in Unified CCE reports.

If Unified CVP fails to send a Whisper Announcement end message to Unified CCE, the following occurs:

- Unified CCE cannot accurately calculate the whisper length, thus skewing report data.
- The agent cannot control the call (for example, put it on hold or transfer it) because these controls are disabled while a Whisper Announcement is playing.

To prevent this, Unified CCE has a Whisper Announcement timeout setting. The value for this setting represents the maximum Whisper Announcement play time that Unified CCE uses to calculate its report data.

The default is 20 seconds. This default is based on the default Whisper Announcement play time (specified in Unified CVP) of 15 seconds. The extra 5 seconds in the Unified CCE fail-safe timeout is a buffer against latency. If you modify the maximum Whisper Announcement play time in Unified CVP, modify the Unified CCE Whisper Announcement fail-safe timeout accordingly.

The Unified CCE Whisper Announcement fail-safe timeout value should be equal to or (preferably) greater than the maximum Whisper Announcement play time setting in Unified CVP. Otherwise, Whisper Announcement play time in Unified CCE reports are under-reported.

To change the fail-safe timeout value, complete the following steps:
Procedure

Step 1  In Unified CCE Configuration, select Tools > Explorer Tools > PG Explorer.
Step 2  Select Retrieve to return a list of PGs (Peripheral Gateways).
Step 3  Double-click the PG with the Generic client type (for example, Generic_PG). The Generic PG has four VRU Peripherals associated with it.
Step 4  Select the first VRU Peripheral listed.
Step 5  On the Peripheral tab, enter the following text in the Configuration Parameters field:
   /WHSTMOUT <value in seconds>
Step 6  Repeat this process for all of the listed VRU Peripherals.
Step 7  Once you are finished, select Save.

Whisper Announcement Sample Scripts

Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as learning tools and as models for your own Whisper Announcement scripts. They are the following:

- **WA.ICMS**—This script plays a Whisper Announcement.
- **WA_AG.ICMS**—This script plays both a Whisper Announcement and an Agent Greeting to play on the same call flow.

The script files are located in the `c:\icm\bin` directory. In Unified CCE Script Editor, they are installed to the application root directory.

**Note**
To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper file stored in the default location on the media server. For that reason, they do not include variables that specify the media server, locale, or application directories.

**WA.ICMS Script**

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.
WA_AG.ICMS Script

This script causes both a Whisper Announcement and an Agent Greeting to play.

Import Sample Whisper Announcement Scripts

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE Script Editor. Follow this procedure to import the scripts:

Procedure

Step 1 Open Script Editor.
Step 2 Select File > Import Script and select the first of the two scripts to import.
In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do not map successfully. You must create these maps manually or change these references to point to existing Network VRU scripts, skill groups, and Precision Queues in your system.
Step 3  Repeat steps 2 and 3 for the remaining script.
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>adding attributes 91</td>
<td>attributes 91</td>
<td>attributes 87, 89, 91</td>
</tr>
<tr>
<td>Agent 45</td>
<td>AgentDeskSettings 66</td>
<td>AgentDeskSettings 66</td>
</tr>
<tr>
<td>log in flexibility 45</td>
<td>configuring 66</td>
<td>configuring 66</td>
</tr>
<tr>
<td>Agent guidelines 73, 78 using the CAD Desktop (Mobile Agent) 78 using the CTI OS Agent Desktop (Mobile Agent) 73</td>
<td>configuring CTI Port Pools 61</td>
<td>configuring CTI Port Pools 61</td>
</tr>
<tr>
<td>Agent profiles 68 CTI OS Server 68</td>
<td>Call delivery modes 46, 47</td>
<td>Call delivery modes 46, 47</td>
</tr>
<tr>
<td>Agent tasks (CAD Desktop) 78, 80, 81</td>
<td>Agent chooses 46</td>
<td>Agent chooses 46</td>
</tr>
<tr>
<td>entering Ready state 80 logging on 78 making calls 80 making conference call 81 transferring calls 81 verifying login 80</td>
<td>call by call 46</td>
<td>call by call 46</td>
</tr>
<tr>
<td>Agent tasks (CTI Desktop) 73, 75, 76, 77 enabling ring tone 76 entering Ready state 76 logging in 73 making calls 77 making conference call 77 making conference transfer calls 77 verifying login 75</td>
<td>nailed connection 47</td>
<td>nailed connection 47</td>
</tr>
<tr>
<td>attributes 87, 89, 91 adding 91</td>
<td>Call flow 54, 55, 56, 57, 58, 59</td>
<td>Call flow 54, 55, 56, 57, 58, 59</td>
</tr>
<tr>
<td>CallManager 61 configuring CTI Port Pools 61 codecs 50 feature support 50</td>
<td>inbound calls 55</td>
<td>inbound calls 55</td>
</tr>
<tr>
<td>Codecs 52 important considerations 52</td>
<td>local consult calls 56</td>
<td>local consult calls 56</td>
</tr>
<tr>
<td>conference requirements 49</td>
<td>Outbound Option calls 59 overview 54</td>
<td>Outbound Option calls 59 overview 54</td>
</tr>
<tr>
<td>Configuration tasks 61</td>
<td>remote conference calls 58</td>
<td>remote conference calls 58</td>
</tr>
<tr>
<td>Configuring 61, 66, 67</td>
<td>remote consult calls 57</td>
<td>remote consult calls 57</td>
</tr>
<tr>
<td>CTI Object Server (CTI OS) 67 agent profiles 67 configuring Mobile Agent 67 IdleTimeout key 67 RejectIfAlreadyLoggedIn key 67</td>
<td>Connect tone 72, 73 enabling 72</td>
<td>Connect tone 72, 73 enabling 72</td>
</tr>
<tr>
<td>Connect Tone 47 features 47</td>
<td>connection modes 45, 47</td>
<td>connection modes 45, 47</td>
</tr>
<tr>
<td>call by call 45 nailed connection 47</td>
<td>CTI Object Server (CTI OS) 67 agent profiles 67 configuring Mobile Agent 67 IdleTimeout key 67 RejectIfAlreadyLoggedIn key 67</td>
<td>CTI Object Server (CTI OS) 67 agent profiles 67 configuring Mobile Agent 67 IdleTimeout key 67 RejectIfAlreadyLoggedIn key 67</td>
</tr>
<tr>
<td>CTI OS Agent Desktop 73 using with Mobile Agent 73</td>
<td>CTI OS Server 67, 68, 73 Agent profiles 68 Installation 67 Mobile Agent connect tone 73 prevent duplicate logins to the same agentID 68</td>
<td>CTI OS Server 67, 68, 73 Agent profiles 68 Installation 67 Mobile Agent connect tone 73 prevent duplicate logins to the same agentID 68</td>
</tr>
</tbody>
</table>
Index

CTI port 45
    DN 45
CTI Port 50, 61
    configuring 61
    requirements 50
CTI Port Pools 63
    Music on Hold (MoH) 63

D
    Device Targets (Configure ICM) 67
        configuring Mobile Agent 67

F
    Failover 51
        important considerations 51
    Fault tolerance 51
    Feature support 50
        call control 50
        codecs 50
        IVR 50
        multichannel 50
        outbound calls 50
        silent monitoring 50

H
    hardware and software requirements 49

I
    Important considerations 51, 52, 53
        codecs 52
        failover 51
        performance 52
        silent monitoring 53
    Inbound call flow 55
    Installation 67
        CTI OS Server 67
    IVR 50
        feature support 50

L
    local agent, defined 43
    Local consult calls 56

Logout non-activity time 66
    configuring 66

M
    Mobile Agent 43, 49, 50, 54, 60, 61, 73
        conference requirements 49
        configuration tasks 61
        CTI Ports requirements 50
        enable connect tone 73
        hardware requirements 49
        limitations 54
        Mobile Agent Scalability 54
            overview 43
            phone requirements 49
            reporting 60
            unsupported features 54
        multichannel 50
            feature support 50
        Music on Hold (MoH) 63
            CTI Port configuration 63

N
    nailed connection 45, 73
        Mobile Agent connect tone 73
    Nailed connection 47
        call flow 47

O
    Outbound calls 50
        feature support 50
    Outbound Option 59
        call flow 59

P
    Performance 52
        important considerations 52
        phone requirements 49
        precision queues 87, 88, 89, 90, 91, 97, 98, 101
            attributes 87, 89
            Consider If 87, 97, 98
            dynamic 101
            expressions 87, 98
            or skill groups 88
            queuing behavior 91
            scripting 90, 101
precision queues (continued)
  static 101
  steps 98
  terms 87
  Wait for 98
  attributes 87, 89
  precision queues 89
    terms 89

R
  Remote Agent 43
    defined 43
  Remote conference call 58
  Remote consult calls 57
  Reporting 60
    Mobile Agent 60
  RONA time 66
    configuring 66

S
  scripting for Packaged CCE precision queues 90
  Silent monitoring 50
    feature support 50
  Silent Monitoring 53
    important considerations 53
  skill groups 88
    or precision queues 88

T
  trunk group settings 68
    configuring 68

U
  Using 73, 78
    CAD Desktop (Mobile Agent) 78
    CTI OS Agent Desktop (Mobile Agent) 73